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Copyright
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Audinate®, the Audinate logo and Dante® are registered trademarks of Audinate Pty Ltd.

All other trademarks are the property of their respective owners.

Audinate products are protected by one or more of US Patents 7747725, 8005939, 7978696, 8171152, European
Patent 2255541, Chinese Patent ZL200780026677.0, and other patents pending or issued. See
www.audinate.com/patents.

LegalNoticeandDisclaimer
Audinate retains ownership of all intellectual property in this document.

The information and materials presented in this document are provided as an information source only. While effort
has been made to ensure the accuracy and completeness of the information, no guarantee is given nor
responsibility taken by Audinate for errors or omissions in the data.

Audinate is not liable for any loss or damage that may be suffered or incurred in any way as a result of acting on
information in this document. The information is provided solely on the basis that readers will be responsible for
making their own assessment, and are advised to verify all relevant representation, statements and information with
their own professional advisers.

SoftwareLicensingNotice
Audinate distributes products which are covered by Audinate license agreements and third-party license
agreements.

For further information and to access copies of each of these licenses, please visit our website:

www.audinate.com/software-licensing-notice

http://www.audinate.com/patents
http://www.audinate.com/software-licensing-notice
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AboutAudinate
Audinate® is the leading provider of professional AV networking technologies globally. Audinate's Dante platform
distributes digital audio and video signals over computer networks, and is designed to bring the benefits of IT
networking to the professional AV industry. AV-over-IP (AVoIP) using Dante-enabled products ensures
interoperability between AV devices and allows end users to enjoy high quality, flexible solutions — typically with a
lower total cost of ownership.

AboutDante

OneConnection. Endless Possibilities.
Dante replaces all audio and video connections with a computer network, effortlessly sending video or hundreds of
channels of audio over slender Ethernet cables with perfect digital fidelity.

Adopted by hundreds of manufacturers in thousands of products, Dante is the de facto standard for modern AV
connectivity.

For more information, please visit the Audinate website at getdante.com.

https://www.getdante.com/
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Introduction

AboutDanteController
Dante Controller is a software application provided by Audinate which
allows users to configure and route audio and video around Dante
networks. It is available for Windows and macOS (see Minimum
System Requirements for more details).

Once you install Dante Controller on your PC or Mac and connect it to
a Dante network, you can use Dante Controller to:

n View all Dante-enabled audio and video devices and their chan-
nels on the network

n View Dante-enabled device clock and network settings

n Route audio and video on these devices, and view the state of
existing audio and video routes

n Route ancillary channels for AV devices

n Connect to Dante Domain Manager and control enrolled
devices

n Lock and unlock Dante devices

n Rename device channels from numbers to names that suit you

n Customize the receive latency (latency before play out)

n Save audio and video routing presets

n Apply previously saved presets

n Edit presets offline, and apply as configurations for new network deployments

n View and set per-device configuration options, including:
o Changing the device name
o Changing sample rate and clock settings
o Viewing detailed network information
o Access the device web page to upgrade firmware and license information (where supported)
o Identify a device for example by flashing LEDs (where supported)

n View network status information, including:
o Multicast bandwidth across the network
o Transmit and receive bandwidth for each device

n View device performance information, including latency statistics and packet errors

n View clock status information for each device, including frequency offset history and clock event logs

n Transmit and subscribe to AES67 RTP multicast audio flows, and SMPTE ST 2110-30 RTP multicast audio
flows

n Configure AV devices via custom control interfaces

The Dante Controller installation package also installs Dante Updater and Dante Activator.

Dante Activator.htm
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What'sNew

v4.18.0
n Added option to receive beta releases of Dante Controller (via the Help menu)

n AES67 flows are sorted by session name alphabetically

n Type-ahead filtering added to the Domain Select list

n Devices on 10 Mbps networks are now highlighted in red in the Matrix and Network View

n TX and RX flow information can now be dumped to a log file for troubleshooting by Audinate Support

v4.17.0
n For supported devices, ST2110 based RTP audio flows can be configured in unmanaged networks (networks

that are not managed via DDM or Dante Director)

n For supported devices, PTPv2-based clocking can be manually configured in unmanaged networks

n AES67 / ST2110 RTP configuration can be saved and loaded in Presets

n For supported devices, additional routing parameters can be configured for RTP audio flows

v4.16.0
n In the View menu, two new options are available:

o Device Scale: Switch between default and compact views for the routing pane
o Swap Routing View Axes: Switch between Receivers on the left and Transmitters on the top, or Trans-

mitters on the left and Receivers on the top

n New signal status icons have been added for encrypted subscriptions

n Support for copying and pasting channel names and subscriptions in the Device View > Receive and Trans-
mit tabs

n Improved support for Dante AV Ultra devices (configuration of HDMI and encoding settings)

n Improved support for Dante AV-A devices (support for USB, IR and serial ancillary data types in the
Advanced Filter)

n Persistent login to Dante Director (closing Dante Controller no longer logs you out of Dante Director)

v4.15.0
n Support for Media Encryption – establish secure subscriptions between devices that support media

encryption functionality. Dante Director is also required to enable this functionality.

n Controller table information extraction – select and copy information in Dante Controller from device tables
(e.g. device info, clock and network status)

n Improvements to usability and application launch speed.

n Addition of AES67 flow latency notification

n Dark mode for video plugins

n Improved translations

n Dante Controller no longer requires fingerprint verification for Dante Director
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v4.14.1
l Signal presence icons updated to improve accessibility

v4.14.0
n User interface look & feel update

o To switch between light and dark modes, select the 'View' menu > Theme

n Improved support for Dante AV devices

v4.13.0
n The 'Use Shared Dante Interface' option has been reinstated to the Configure Dante Interfaces dialog.

v4.12.0
n Dante Updater support for Dante Pro S1

v4.11.1 (Windows only)
n Dante Controller now uses OpenSSL 3.0 for secure connections (updated from OpenSSL 1.1.1)

n Improved support for future Dante Management solutions

n The 'Use Shared Dante Interface' option has been removed from the Configure Dante Interfaces dialog, to
provide a simpler and more consistent user experience across Audinate software products

v4.9.0
n Improved notification on media flow vulnerability after Tx channel renaming

n Dante Controller support for auto-detection of video format for Dante Studio receive channels (requires Dante
Studio v2.1.0 or above)

Previous releases

v4.8.1
n Dante Updater support for firmware update and failsafe recovery of newly-released Brooklyn 3 (Dante device

type) hardware

v4.7.0
n Support for Dante AV and Bluetooth AVIO configuration in DDM/Dante Director environments

v4.6.0
n Support for multiple language options for the user interface: English, Spanish, French, German, Portuguese,

Chinese, Japanese and Korean

o To change the language, from Network view, select View > Language

v4.5.1
n Dante Activator is now installed with Dante Controller

o Dante Activator is a new application that allows you to purchase and activate additional Dante channels
for supporting Dante Ready™ devices.

n Support for Windows 11

Dante Activator.htm
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n New DDM / Dante Director Login dialog (combines the DDM user and DDM server login functions)

n New feature: Connect Devices to DDM / Dante Director (for DDM networks)

v4.4.0
n Support for Apple M1 architecture

n Native support for 64-bit Windows
o 32-bit Windows is no longer supported

n New user guide content: Resolution and Timing for Dante AV Devices

v4.3.3
n Support for Dante AV (video) devices. For more information, see:

o Routing for Video Devices
o Plugins

n New signal status icons for video and ancillary channels (Receive Tab and Transmit Tab)

n The Advanced Filter has been updated:
o The Subscriptions filter now includes extra options
o The Latency and Sample Rate filter options are now dynamic based on product type
o New filters have been added for Media Type, Video Subtype, and Ancillary Type

n Channel labels have been deprecated - all channel names are now user-editable (Device and Channel
Names)

n Inclusive language changes to clocking terminology:
o Some of the terminology used in Dante products has been changed to align with modern usage. Spe-

cifically, areas related to Dante clocking now refer to “Primary Leader Clock”, “Leader Clocks” and “Fol-
lower Clocks” to describe the functions of each role more clearly.

n Support for macOS 11 Big Sur

For more information about new features, please see the Dante Controller release pages at audinate.com.

v4.2.5
Support for macOS 10.15.

SystemRequirements
The tables below list the system specifications for your computer to be able to use Dante Controller.

Disclaimer: It is possible that your computer may meet the requirements below, but suffer from some other
individual performance limitation related to its particular hardware. Please seek the advice of your computer support
administrator.

General

Component Minimum Requirements

Processor 1GHz or better

Memory 512Mbyte of RAM

https://my.audinate.com/support/downloads/dante-controller
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Component Minimum Requirements

Network Standard wired Ethernet network interface (100Mbps or Gigabit) or
wireless LAN (Wi-Fi) interface

Windows

Component Requirements

Operating System For supported platforms, see the latest release notes at getdante.com

NOTE: Both UTF-8 and Unicode are supported EXCEPT for host or device
names; the DNS standard does not support Unicode for these

Hardware 64-bit architecture

macOS

Component Requirements

Operating System For supported platforms, see the latest release notes at getdante.com

Hardware Intel or Apple M1

Operating SystemUpdates
Ensure your PC or Mac has the latest Windows or Apple updates installed.

FirewallConfiguration
Firewall configuration for Windows Firewall and macOS built-in firewall is automatically handled during installation.

If you are using a third-party firewall product, please refer to this Audinate FAQ for more information about Dante
ports.

https://www.getdante.com/support/software-downloads/
https://www.getdante.com/support/software-downloads/
https://www.audinate.com/faq/which-network-ports-does-dante-use


Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -19-

InstallingDanteController

DownloadingDanteController
Dante Controller is available for download from Audinate’s website.

To download a copy of Dante Controller:

1. Go to the Dante website: getdante.com.

2. Navigate to Products > Dante Controller.

3. Click 'Dante Controller Free Download'.

4. Click the relevant link for your operating system.

Note: You will need an audinate.com web account.

InstallingDanteControlleronWindows
Once you have downloaded the self-installing Dante Controller file, navigate to the directory where you have
downloaded it (e.g. Desktop).

To install:

1. Ensure you are logged on to your PC as an administrator.

2. Navigate to and double-click the Dante Controller installer file.

3. Read the license agreement. If you agree to the terms, select the 'I agree' checkbox and click Install. If you do
not agree to the terms, click Close.

4. Confirm / acknowledge any Windows security prompts that are displayed.

Dante Controller will then be installed. Dante Controller will be added to the start menu, under 'Audinate'.

Note: Dante Updater will also be installed automatically.

InstallingDanteControlleronmacOS
To install Dante Controller on macOS:

1. Double-click the Dante Controller .dmg file. A drive icon will appear on your Desktop Finder window. Double
click on this to open.

2. Double click the Dante Controller .pkg. This will run the installer.

3. Read the license text, and if you accept the terms of the agreement, click Agree.

If you do not accept these terms, click Disagree to terminate the installation.

Note: Dante Updater will also be installed automatically.

https://www.getdante.com/
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UpdatingDanteController
Dante Controller can be updated directly from the application itself.

Note: Requires an active Internet connection.

Checking for UpdatesManually

In Windows:

From the Help menu, select 'Check for Updates'.

In macOS:

From the Dante Controller application menu, select 'Check for Updates'.

Checking for Updates Automatically

Dante Controller can also check for updates automatically. If an update becomes available, you will be notified via a
pop-up message.

To activate automatic checking, in the update dialog, select the option to check for updates automatically.

UninstallingDanteController
You should not need to uninstall Dante Controller before installing a new version.

However, if you do wish to uninstall Dante Controller:

Windows

Navigate to Control Panel > Programs and Features, select Dante Controller and click Uninstall.

Note: Two other Dante features, 'Dante Control and Monitoring' and 'Dante Discovery', may still be present in
the programs list after uninstalling Dante Controller. Do not uninstall these features if they are present - they
are required by other Dante software applications (for example, Dante Virtual Soundcard, Dante Updater, and
third-party Dante control applications). They will be removed automatically if they are no longer required.

macOS

Use the Uninstall tool available in the .dmg file.
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DanteBasics

Discoveryandauto-configuration
When a Dante-enabled device is connected to an IP/Ethernet network, it will automatically:

1. Configure its IP address

2. Advertise itself to allow automatic discovery

Within seconds of a Dante-enabled device connecting to a network, Dante Controller will automatically discover and
display the device, allowing you to configure channels and route media.

Automatic network configuration

A Dante-enabled device connected to a network will automatically setup its own network configuration, including its
IP address.

If the network has a DHCP server, which may be the case for installed networks, it will receive its IP configuration
using the standard DHCP protocol.

On a network without a DHCP server, which may be the case for temporary or smaller networks, the Dante-enabled
device will automatically assign itself an address using link local protocols, in the same way PCs and printers often
do.

Automatic discovery

A Dante-enabled device will advertise information about itself to other Dante devices and Dante Controller,
including:

n Device name

n Channel names

n Number of channels

n Sample rates and bit depths

This information can be seen when viewing a device on Dante Controller, and allows Dante devices to determine
compatibility with other devices, such as compatible sample rates to allow media to be routed.

DeviceChannels
A Dante device has a number of channels associated with it. These are either transmit (Tx) or receive (Rx)
channels. Receive channels and devices are listed down the left side of the grid. Transmit channels and devices are
listed along the top of the grid.

Transmit channels are advertised on the network. A receiver uses this advertisement to establish a subscription to
the channel. A transmit channel can be sent to multiple receivers using unicast or multicast.

Note: Ancillary channels on AV devices cannot be sent via multicast.
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Receive channels are connected to transmit channels via a subscription. Each receive channel will receive media
over the network from at most one transmit channel.

Subscribing toMedia Channels

In the Routing View, a blue square at the intersection of an Rx and a Tx channel indicates that is it possible to create
a media route between those channels. A grey square indicates that it is not possible to create a route between
those channels. This may be because of a mismatch in sample rate between the transmitter and receiver, or
because a device cannot route to itself.

When you click a blue square at the cross-point between a transmit channel and a receive channel, a subscription

will be created, and a green tick  will appear in the matrix cross point. You may initially see a grey hourglass

icon  (usually very briefly) to indicate that the subscription is in progress.

If there is a problem with the subscription, either a warning   or an error icon may appear. If many

devices have been subscribed at the same time, a yellow pending icon may appear temporarily. Hover the

mouse over subscription icons to see a related tooltip (see Subscription Tooltips).

Note: Subscriptions can also be created in the Device View. This is covered in the Device View section.

Note: You cannot create new subscriptions to a locked device; however, existing subscriptions can be
removed and replaced.

Subscribing toMultiple Media Channels at once
To subscribe multiple channels at the same time, hold down the Ctrl key and click the [-] symbol at the top left corner
of the intersection between the two devices. All possible channels will be subscribed at the same time (see the
figure in Expanding the Routing View).

UnsubscribingMedia Channels
To unsubscribe a media channel, click on the cross-point containing a subscription. The subscription icon will be
removed and revert to a plain blue square.

Subscription Status
The symbol displayed at the intersection of the Tx channel and the Rx channel in the Routing View provides
information on the status of the subscription or connection, as follows:

In progress The subscription is in progress

Subscribed Connection is established and fully functional
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Warning This may indicate that:

n The subscription is unresolved, possibly because the transmitting device
is not visible on the network (for example, because it has been removed,
or switched off); or:

n There is another connectivity issue in the physical network that is
affecting a media signal

Error An error has occurred - for example, there is insufficient bandwidth to
establish the subscription

Pending Device is part-way through setting up subscription. Most commonly seen
when subscribing many channels at a time

Note: The status of a subscription can change after it has been initially established, due to changes in the
network or changes in other devices.

Additional icons are used for devices that support Media Encryption.

Subscription Tooltips

Hovering the mouse over a subscription icon in the Routing tab displays a tooltip containing information about the
subscription.

If there is no problem with the subscription, the tooltip will display the Rx channel and device name, plus the Tx
channel and device name (for example, 'kick@Monitor-Console <- 01@Stagebox-2'), plus the subscription status,
and for successful subscriptions, the subscription type (unicast / multicast).

Other messages are displayed if the subscription is in any other state.

Some common messages are:

n 'Incorrect channel format: source and destination channels do not match'

The receiver and transmitter are set to different sample rates.

n 'Mismatched clock domains: The transmitter and receiver are not part of the same clock domain'

One of the devices is configured with sample rate pull-up/down that does not match the other device.

n 'Tx Scheduler failure'

This is typically because you are trying to use sub-millisecond latency over a 100 Mbps network link (1 msec
is the minimum supported latency over 100 Mbps links).

n 'No Receive flows: receiver cannot support any more flows'
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Indicates the receiver is subscribed to too many devices (devices typically do not support the same number of
flows as they do channels). See Routing Audio > Flows for more information.

n 'No more flows (TX): transmitter cannot support any more flows'

Indicates that too many devices are subscribed via unicast to the transmitter. See Fanout for more
information.

n 'Cannot change: Locked receiver.'

Indicates a subscription from a locked receiver. Subscriptions from locked receivers cannot be changed.

n 'Warning: Locked transmitter.'

Indicates that the transmitter is locked. You cannot create new subscriptions to a locked transmitter.

n 'Access control failure: Transmitter is locked.'

Indicates a subscription that failed because the transmitter is locked.

DifferentiatingBetween InputandOutputChannels
Channels are classified according to whether they put data onto, or take data off the network:

n A channel that puts data onto the network is known as a transmitting, Tx or output channel.

n A channel that takes data off the network is known as a receiving, Rx or input channel.

DeviceandChannelNames
In Dante, devices and media channels are identified by names, not 'magic numbers'. Device and channel names
can be customized.

n Dante routing is performed using the Device and channel names. A receive channel can be subscribed to the
name of a transmit channel at a device.

Example: “Analog L@my-transmitter” describes a channel named “Analog L” on a
device named “my-transmitter”. Device names must be unique on a Dante network.
Channel names must be unique on the device.

n If a device or channel is renamed, Dante routing considers it to be a different device or channel. If a new
device or channel is then given the old name, Dante routing will route from the new device in place of the pre-
vious device.

Example: The power supply on “stage-box” fails and “stage-box” needs to be replaced.
The old “stage-box” is removed, and a new box is plugged in and named “stage-box”.
Dante receivers previously subscribed to the old “stage-box” will now automatically restore
their subscriptions to the new “stage-box”.

n Device names must be unique on the network. If you attempt to rename a device using Dante Controller to a
name that is already in use on the network, Dante Controller will notify you and reject the name change.

Example: There is an existing device on the network called “MY16-slot1”. If user attempts
to rename another device to “MY16-slot1” Dante Controller will notify you that the name is
already in use. The device will not be renamed.

n If a new device is added to the network with a name that already exists, a name conflict is detected. One of
the devices will adopt a temporary placeholder name, by appending a space and (2) to its old name. This



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -25-

device will not be able to transmit media until it is manually renamed, and some configuration options will be
disabled for that device in Dante Controller.

Note: A device that has been renamed with (2) appended (e.g. “MY16-slot1 (2)”) will not be able to transmit
media until it is renamed. The device name must be changed by the user to be a valid non-conflicting name
before the device can become fully functional. A device that has failed with a name conflict will retry its
configured name if it is rebooted. If the other device has been removed or renamed, the previously failed
device will resume normal operation.

Rules for Names
n All Dante names are up to 31 characters in length.

n Name comparisons are case-insensitive: “Guitar” and “guitar” are treated as the same name.

n Unicode and non-roman characters are not supported.

n Device names should follow Domain Name System (DNS) hostname rules. Legal characters are A-Z, a-z, 0-
9, and '-' (dash or hyphen).

n Device names cannot begin or end with a hyphen.

n Device names must be unique on the network.

n Tx channel names may use any character except '=' (equals), '.' (full stop or period), or '@' (at).

n Tx channel names must be unique on a device. Tx channel names do not need to be unique on the network,
as they are always qualified by device (channel@device).

n Rx channel names follow the same rules as Tx channel names .

RoutingMedia

Routing Terminology
n Device: A device means a Dante-enabled device, and more specifically that component of the equipment

that implements the Dante interface. A Dante device typically has Tx and Rx channels and other routing-
related properties.

n Transmit (Tx) channel: A transmit channel transmits media from the media hardware onto the network.

n Receive (Rx) channel: A receive channel receives media from the network and sends it to the media hard-
ware.

n Flow: Dante media routing creates flows. Each flow carries several channels of audio, or one channel of
video from a transmitter to one or more receivers. Unicast routing creates flows to single receivers. Multicast
routing creates flows that can be received by multiple receivers. Multicast flows are assigned IDs enabling
them to be identified in Dante Controller.

n Unicast routing: Unicast flows are point-to-point from a single transmitter to a single receiver. Unicast flows
typically have room for 4 channels of audio or 1 channel of video.

n Multicast routing: Multicast flows are one-to-many from a single transmitter to any number of receivers. Use
Dante Controller to choose which channels are to be multicast. Unlike unicast routing, multicast flows con-
sume network bandwidth even if there are no receivers, but do not require additional bandwidth to add more
receivers. Multicast flows can carry Dante audio, or RTP audio (AES67 or ST 2110-30).

n Subscription: A subscription configures a receive channel to receive media from a transmit channel on
another Dante device.

n Subscription status: For a receive channel, subscription status indicates whether it is subscribed, whether it
is receiving unicast or multicast media, whether the subscription is OK, or whether an error has occurred.
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Subscription

Dante routing is performed by associating a receiving (Rx) channel with a transmitting (Tx) channel. This is called
'subscription'.

Example: Route Tx channels 1 and 2 (named “Audio L” and “Audio R”) on the device named “Source” to Rx
channels 3 and 4 on the device named “Dest”.

Rx channels 3 and 4 on “Dest” are subscribed as follows:

n 3. Audio L@Source

n 4. Audio R@Source

Dante will perform the necessary routing to deliver the media from the Tx channels to the Rx channels.

Redundancy

Many Dante devices support redundant media routing. These devices have two network interfaces, named primary
and secondary. Primary interfaces should be connected to one physical network. If redundancy is being used,
secondary interfaces should be connected to a second separate network. Secondary interfaces cannot
communicate with primary interfaces.

If the secondary network is connected to a device that supports redundancy, it is enabled automatically. The same
media data is transmitted on both the primary and secondary networks simultaneously. In the event of a failure on
one network, media will continue to flow via the other network.
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Note: Dante redundancy requires that both the primary and secondary interfaces on any redundant device
are connected using the same link speed. For example, if the primary interface is connected to a 1 Gbps
switch port, the secondary interface must also be connected to a 1 Gbps switch port. Similarly, if the primary
interface is connected to a 100 Mbps switch port, the secondary interface must also be connected to a 100
Mbps switch port.

Note: Dante devices that do not support redundancy must be connected to the primary network only.

Media Formats

Most Dante devices support a range of media formats (audio sample rates, or video resolutions). Devices can
usually be switched between media formats, but will not support more than one at a time.

It is only possible to set up a subscription between channels which have a common media format. Channels on
devices with incompatible formats will be shown in grey, and will not be routable.

Flows

Dante media routing creates 'flows'. Each flow carries one or more channels of audio, or one channel of video from
a transmitting device to one or more receiving devices. There are two types of flow, unicast and multicast.

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 4 channels of
audio, or 1 channel of video. Unicast flows are set up when a receiver subscribes to an available media channel,
and are automatically removed when the receiver unsubscribes from all channels in that flow.

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned IDs, enabling
them to be identified in Dante Controller, and to facilitate their removal. In contrast to unicast flows, multicast flows
must be set up on the transmitting Dante device before receivers can subscribe to these flows.

Advanced Routing: UsingMulticast

Dante routing is unicast by default. This means that a separate flow is set up between each transmitter and receiver.
If several receivers are all subscribed to the same channels of a transmitter, it may sometimes be more efficient to
use multicast.

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that the flow is
flooded throughout the network. If many receivers want the same channels, using multicast can reduce overall
network use, especially on the transmitter, because only one copy of each channel needs to be sent, rather than
many.

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a new multicast flow
is created containing the channels that a receiver is currently receiving as unicast, the receiver will switch over to
receiving media from the multicast flow and the unicast flow will be removed.

Multicast flows can carry Dante audio, or RTP audio (AES67 or ST 2110-30). These RTP flows are visible in Dante
Controller and have specific configuration and compatibility requirements.

Routing for Video Devices

Video (Dante AV) devices support three major channel types.
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Audio Channels
Audio channels are represented in Dante Controller by the following icon:

Audio channels for Dante video devices are treated and managed identically to audio channels for audio-only Dante
devices.

Video Channels
Video channels are represented by the following icon:

Video channels contain packetised video data streams, and can be routed in the same way as audio channels.
However, they typically use more bandwidth than audio channels, and require 1Gbps (or higher) switch ports.

Note: IGMP snooping must be enabled on network switches that will be carrying Dante video on 1Gbps
network infrastructure. Refer to your switch manufacturer's documentation for information about enabling
IGMP snooping.

Ancillary Channels
Ancillary channels are represented by the following icon:

Ancillary channels are 'custom' channels, defined by the device manufacturer, to carry additional data (not audio or
video) between devices. Typically they are used to carry hardware control data, such as USB peripheral or infrared
transport control data.

Ancillary channels are typically low bandwidth (compared to audio and video channels).

Some ancillary channel types cannot be added to multicast transmit flows.

A typical Network view for a network that includes video devices (with four types of ancillary channels) is shown
below.

In this example:

n The 'Video Rx' channel on the AV-Display-FOH receiver is subscribed to the 'Video Tx' channel on the AV-
Mixer transmitter.

This subscription would cause video from the AV mixer to be displayed on the front of house display screen.

n The '01' and '02' audio channels on the Amp-FOH1 audio receiver are subscribed to the 'Left' and 'Right' Tx
channels on the AV-Mixer transmitter.

These subscriptions would cause the left and right audio channels from the AV mixer to be played out via the
front of house amplifier.

n The 'USB' and 'IR' ancillary channels on the AV-Display-FOH receiver are subscribed to the equivalent
channels on the AV-Mixer transmitter.

These subscriptions would enable USB peripheral (for example, mouse and keyboard) and infrared control of
the transmitter via the control ports on the receiver.



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -29-

Note that control data on some types of ancillary channel (somewhat counter-intuitively) may actually flow
from the receiver to the transmitter. This enables transmitting video sources to be controlled remotely at the
receiver. For example, you could start and stop a Blu-Ray player (a transmitter) in another room using an
infrared remote control pointed at the screen that is actually playing the video (a receiver).
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ClockSynchronization

In Standard Dante Networks

All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to synchronize
their local clocks to a leader clock, providing sample-accurate time alignment throughout the network.

One Dante device will be elected as the PTP Leader Clock for the network; all other Dante devices act as a PTP
Follower Clocks to the elected leader clock. Although many Dante devices may be capable of becoming PTP
Leader Clock, only one device will win the election. Devices with clock inputs (e.g. Word Clock or AES3) will be
preferred in the election process. A gigabit connected device is preferred over a device connected via 100Mbps. A
tie-breaker rule of the lowest MAC address is used if several equivalent candidate leader clocks are available. The
election process may be overridden by manually setting 'Preferred Leader' on a device.

Two versions of PTP exist: PTPv1 and PTPv2. By default, Dante devices use PTPv1. However, when RTP is
enabled for a device, it also uses PTPv2 (which can be specifically configured via the Clock Config tab) and PTPv1
can be disabled if required.

Dante Clock Types
Each Dante hardware device can derive its clock from either its high-quality onboard clock circuit, or an externally
connected word clock. In the case of Dante Virtual Soundcard, the computer’s clock will be used.

Clock Settings

Enable Sync To External

A Dante device set to 'Enable Sync To External' will use the external word clock from its host equipment to tune its
onboard VCXO. A Dante device with this attribute set will become the PTP Leader Clock, unless there is another
Dante device present with 'Preferred Leader' set.

Preferred Leader

Sometimes it may be necessary to force a particular device to provide the PTP Leader Clock. A Dante device with
'Preferred Leader' set will always be chosen as the PTP Leader Clock. If more than one device has 'Preferred
Leader' set, the device with the lowest MAC address will be chosen.

Note: If device A is deriving its clock from an external word clock source ('Enable Sync To External'), but
device B is set as Preferred Leader, device A will lose sync with the Dante network and will eventually be
muted - unless device B is also deriving its clock from the same external source as device A.

Note: Preferred Leader is not supported for devices in ST 2110-30 mode or AES67 Manual mode (but is
supported for devices in AES67 Auto mode).

Clock Status
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Clocking and Synchronization in Redundant Networks
In a redundant network, the clock synchronization protocol operates over both primary and secondary networks.
Each network will have a designated PTP leader clock; usually this will be the same device on both networks. If this
is not the case (e.g. if a non-redundant device is designated Preferred Leader) then one device will bridge the clock
synchronization information from the primary to the secondary network, ensuring that all devices derive their clock
from the same source. Redundant PTP Follower clocks will synchronize their local clocks based on information from
one of the networks they are connected to. In event of a failure on one network, a redundant device will continue to
receive clock synchronization information over the other network.

In Dante Domains

In Dante domains, there is one Primary Leader clock, and if the domain spans IP subnets, an additional 'subnet
leader' clock for each subnet, plus one or more boundary clocks for each subnet. The subnet leader may also be a
boundary clock for its own subnet.

Boundary clocks use PTP v2 (IEEE 1588-2008) for unicast clocking between subnets. Boundary clocks can be
manually or automatically specified using the DDM web interface.

Each Dante domain will use its own individual clock domain, unless media sharing between domains is configured,
in which case all domains in the shared media group share the same clock domain.

Latency

For Audio Devices

For Dante audio devices, variation in latency in the network is compensated for at the receiver. Each receiver has a
device latency setting. This setting defines the latency between the timestamps on the incoming audio samples and
when those samples are played out.

The typical default latency for a Dante audio device is 1 msec. This is sufficient for a very large network, consisting
of a Gigabit network core (with up to 10 hops between edge switches) and 100 megabit links to Dante devices.
Smaller, Gigabit-only networks can use lower values of latency (down to 150 µsec for very fast devices, such as
PCIe cards). Recommended latency settings are displayed in Dante Controller, and may also be found in the
documentation accompanying the product.

Latency is set on the receiver. However, when a subscription is made, there is an automatic negotiation process
between the receiver and the transmitter, to ensure that the latency for the subscription is high enough to prevent
packet loss.

For example, Ultimo devices support a minimum of 1ms latency. If a faster device (such as a PCIe card) is set to
0.25ms latency, and is then subscribed to an Ultimo transmitter, the latency used for the subscription will be 1ms,
which is the minimum supported latency for the subscription. Subscriptions to other devices (such as a Brooklyn II
device) will be set at 1ms (or whatever latency the receiver is set to). This effectively makes the device latency
setting a 'default' latency, which is used unless the transmitter doesn't support it.

If the transmitter and receiver have different latency settings, Dante will use the higher of the two as the
effective flow latency.



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -32-

Note: The minimum latency available for a device connected to a 100 Mbps network port is 1 msec.

Using a latency lower than 1 msec over a 100 Mbps link will result in a subscription error, with the tooltip 'Tx
Scheduler Failure'.

Latency Monitoring
Dante Controller provides latency monitoring for supported devices. For more information, see Latency Tab.

Latency and Dante Virtual Soundcard
Dante Virtual Soundcard allows a standard Apple Mac or Windows PC to function as a Dante device. Because
Dante Virtual Soundcard runs on a general purpose computer without special hardware to support Dante timing
requirements, additional latency needs to be added to connections received from a Dante Virtual Soundcard
transmitter.

Dante Virtual Soundcard is configured with custom latency values for reliable operation. Dante devices with Rx
channels that are subscribed to Tx channels from a Dante Virtual Soundcard transmitter will automatically configure
themselves to use these higher latency values for those channels only. The latency on all other subscriptions on the
receiver is unaffected.

Latency in DDM Networks
Devices that are enrolled in a Dante domain may support extra latency values, to accommodate larger network
topologies.

If a device is un-enrolled while it is set to one of these latency values, its latency will be automatically reset to the
default value for the device.

For Video Devices

For video (Dante AV) devices, the Device Latency setting in Dante Controller applies to the audio channels only.

DeviceLock
Device Lock allows you to lock and unlock supported Dante devices using a 4-digit PIN (Personal Identification
Number).

When a device is locked, media will continue to flow according to its existing subscriptions, and it can be monitored,
but it cannot be controlled or configured – its subscriptions and configuration settings become read-only.

To configure a locked device you must first unlock it using the PIN with which it was locked.

Locked devices can be identified by:

n

A small padlock icon against the device name in the Network View > Routing tab

n A check (tick) in the Device Lock column in the Network View > Device Info tab

n

A highlighted padlock icon in the Device View toolbar 

Not all Dante devices support Device Lock.
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To check if a Dante device can be locked:

n Use the Advanced Filter to check for locked, unlocked and unsupported devices

n Check the Device Info tab – devices that support Device Lock have a checkbox in the Device Lock column;
devices that do not support Device Lock show ‘N/A’ in the Device Lock column

n Open the device in Device View – if the padlock icon in the toolbar is blue or red, the device supports device
lock; if it is grayed out, it does not support Device Lock

n If in doubt, contact the device manufacturer

Locking a Dante device

To lock an unlocked Dante device:

Using Device View

1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon 

The Lock Device panel is displayed.

2. In the Lock Device panel, enter a 4-digit PIN in the PIN field.

3. Enter the same PIN in the Confirm PIN field.

4. Click ‘Lock’.

The padlock icon will become highlighted indicating that the device is now locked.

From the Device Info Tab
1. In Network View, select the Device Info tab.

2. Click the Device Lock checkbox for the device.

3. Follow steps 2-4 from the above process.

Unlocking a Dante Device

To unlock a locked Dante device:

Using Device View

1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon

2. In the Unlock Device panel, enter the 4-digit PIN in the PIN field.

3. Click Unlock.

The padlock icon will lose its highlighting   indicating that the device is now unlocked.

From the Device Info Tab
1. In Network View, select the Device Info tab.

2. Click the Device Lock checkbox for the device.

3. Follow steps 2-3 from the above process.

device lock dialog.png
device lock checkbox.png
unlock device dialog.png
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Unlocking a DeviceWhen You Have Forgotten the PIN

If you have forgotten the PIN for a locked device, you can reset the PIN.

To reset the PIN for a locked device:

1. Isolate the device from the rest of the Dante network.

2. Disconnect and reconnect the device.

3. Wait for at least 2 minutes.

4. Use the ‘Forgot PIN’ option in the Unlock Device panel.

How to Isolate a Device from the Rest of the Dante Network
There are 3 ways to isolate a device from the rest of the network.

Option 1: Remove all other Dante devices from the Dante network

You can isolate a device by physically disconnecting all other Dante devices from the network switch, or by
completely powering down all other devices, leaving on the network only the locked device and the computer
running Dante Controller.

Note: Dante Virtual Soundcard and Dante Via are considered to be Dante devices – all running instances of
those applications must be fully stopped, even if they are on the same computer on which you are running
Dante Controller.

Option 2: Connect your Dante Controller computer directly to the device

Physically remove the device from the main Dante network switch, and either connect it directly to your Dante
Controller computer (using a normal Ethernet cable), or connect the device and your computer to a separate
network switch (to which there are no other Dante devices connected).

Option 3: Use a VLAN

Set up a Virtual Local Area Network  on which there are only the locked device, and the Dante Controller
computer.

Resetting the PIN for a Locked, Isolated Device
Once you have isolated the locked device, disconnected and reconnected it, and then waited for at least 2 minutes:

1. Open the Unlock Device panel for the device (See Unlocking a Dante Device).

2. Click the ‘Forgot PIN’ option.

3. Click Reset.

The device is now unlocked, and can be re-locked using a new PIN if required.

Subscriptions fromUnlocked Devices to Locked Devices

If there are existing subscriptions to a device when it is locked, those subscriptions will continue to function as
normal.

They can also be removed, and replaced (assuming the subscribing device is unlocked).

http://www.yamahaproaudio.com/global/en/training_support/selftraining/dante_guide/chapter2/03_vlan/
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No new subscriptions can be made to a locked transmitter. The 'Access control' tooltips are associated with
attempted subscriptions to locked transmitters.

Note: If you attempt to subscribe a legacy (pre-v3.10 firmware) receiver to a locked transmitter, subscription
status icons for any existing subscriptions (made before the device was locked) may change to indicate an
error state. However, audio will continue to flow for those subscriptions. To reset the subscription icons:
Remove all subscriptions, and reinstate the original subscriptions only.

Locking Devices with Residual Connections

Occasionally, a transmitter will have residual unused connections (transmitting but unsubscribed channels) from a
previous subscription state, which need to be closed before the device is locked. This can cause an interruption to
media from that device.

When you attempt to lock a device and residual connections are detected, Dante Controller presents a warning
dialog:

Click Ok to proceed or Cancel to abort the lock process.

While the residual connections are being closed, Dante Controller displays a progress dialog:

When the preparation process is finished, the standard Lock Device dialog is presented, and the device can be
locked as normal.
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DanteControlandMonitoring
In addition to automatic configuration and discovery, media transport and routing, Dante-enabled devices can also
be controlled and monitored in various ways. This includes being able to view and change specific parameters, such
as clock configuration settings. Dante devices are also capable of sending status events that can be viewed using
Dante Controller. Status events include changes in clock status, or network interface changes.

Note: The computer service that manages control and monitoring is called 'ConMon' or 'Dante Control and
Monitoring'.
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StartingDanteController

WheretofindtheDanteControllerapplication

Windows

By default Dante Controller will be installed in

C:\Program Files (x86)\Audinate\Dante Controller\

It can be started in several ways:

n Using the Start menu: Start > Audinate > Dante Controller > Dante Controller

n Run by going to Start > Run and entering
C:\Program Files\Audinate\Dante Controller\DanteController.exe
in the dialog box

n
Navigate to the directory where it is installed, and double-click the Dante Controller icon:

macOS

The Dante Controller application will be installed in the Applications folder.

To start:

n
Navigate to Applications folder, and double-click the Dante Controller icon:

Or:

n Drag the icon to the Dock and click on it

ConfiguringDanteController

Network Interface Selection

Dante Controller can communicate with other Dante devices on the primary network, or the secondary network, or
both. Dante Controller needs to know which of the network interfaces of the host computer is connected to each
physical Dante network.

Dante Controller supports connection to Dante networks via Ethernet and Wi-Fi network interfaces.

The first time Dante Controller is run, you may be presented with the Configure Dante Interfaces dialog (shown
below). Use this dialog to select the primary and secondary Dante interfaces. Once interfaces have been selected,
they are remembered for future use, and this dialog will not be shown when Dante Controller is run subsequently.
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Note: In DDM networks, Dante Controller may use a different interface to connect with Dante devices.

Note: When connecting a network interface on your computer to a secondary Dante network with no
DHCP server, the network interface should be configured with a static IP address in the 172.31.*.* range, with
a subnet mask of 255.255.0.0.

The icons displayed indicate the selected interface type and status:

Operational 1Gbps Ethernet interface

Operational 100Mbps Ethernet interface

Disabled / disconnected Ethernet interface, or no interface selected
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Operational Wi-Fi interface

Wi-Fi interface selected with no Wi-Fi network connection

To display this dialog at any other time, click the  button in the main toolbar.

Use Shared Dante Interface
With this option selected, in unmanaged mode (when Dante Controller is not logged into DDM or Dante Director),
the selected primary network interface will be automatically used by third-party applications from Dante device
manufacturers when they are started. This helps to ensure that all applications are connected to the same Dante
network.

Only wired Ethernet network interfaces are supported in this mode.

Note: Selecting ‘Use shared Dante interface’ when another Dante application is already running means that
you can only use the network interface that is in use by the other running Dante application (the interface has
already been nominated as the 'shared Dante interface').

With ‘Use shared Dante interface’ deselected, Dante Controller is able to connect to any available Ethernet or Wi-Fi
network interface, and the selection is fully independent of any other software applications.

In managed mode (when Dante Controller is logged into DDM or Dante Director) the Shared Dante Interface
selection is ignored.

Wi-Fi Network Connections
To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be present and enabled on the Dante network -
for example, a Wi-Fi router physically connected to a network switch or Dante device in the Dante network.

Note: Dante audio and video transmission over Wi-Fi is not supported.

To connect to a Dante network using Wi-Fi:

1. Ensure your Wi-Fi interface is successfully connected to a Wi-Fi network.

2. Ensure ‘Use shared Dante interface’ is deselected.

3. Select your Wi-Fi network interface in the Configure Dante Interfaces dialog.

See also: Using Wi-Fi and Multicast Transmit Flows

Network Interface Configuration Guidelines

Primary only (non-redundant) Dante network
If you only have a primary network, you can only connect one interface to the Dante network.
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Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to the switch
via their primary interfaces. This is a typical non-redundant Dante network.

If the laptop has two network interfaces, either can be used.

Primary and secondary Dante networks (redundant configuration), only one network
interface on the host computer
If you have primary and secondary (redundant) networks, but only one network interface on your computer, you
should set your computer's network interface as the primary interface. This ensures that you can control any non-
redundant devices, and see full connection information for any redundant devices that are connected to non-
redundant devices.

If a problem does occur, and you lose connectivity on the primary network, you can connect instead to the
secondary network, to maintain control over your devices. This entails changing the physical connection (i.e.
physically connecting your computer to a switch on the secondary network), and changing the interface selection in
the Configure Dante Interfaces dialog.

Example
In the example below, the laptop (running Dante Controller) is connected to the switch via one interface only, which
is set as the primary Dante interface.

The two Dante devices are connected to the primary switch via their primary interfaces, and to the secondary switch
via their secondary interfaces. The two switches are not connected to each other. This is a typical redundant
network configuration for computers with only one network interface.
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Note: When connected to the secondary network, you will not have control over devices that are only
connected to the primary network (i.e. non-redundant devices, or Dante Virtual Soundcard). You will see the
device names in the Network view, and in subscription dialogs (for example, the Device View > Receive and
Transmit tabs) but you will not be able to view or edit device configuration for those devices. Also, if the leader
clock is only connected to the primary network, its name will not resolve in the 'Leader Clocks' section of the
main window tool bar, it will be shown as a MAC address string.

Primary and secondary networks (redundant configuration), two network interfaces
on the host computer
If you have primary and secondary networks, and two network interfaces available on the host computer, you
should connect one interface to each network. This means that you will always have full control of all redundant
devices, even if the primary network fails.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to the primary
switch via their primary interfaces, and to the secondary switch via their secondary interfaces. The two switches are
not connected to each other. This is a typical redundant network configuration for computers with two (or more)
network interfaces.
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Note: All Dante applications on the same computer have a shared understanding of which interface is the
primary Dante interface. For example, if you have installed Dante Virtual Soundcard on the same computer as
Dante Controller, and a new primary interface is selected from within Dante Virtual Soundcard, Dante
Controller will automatically switch to the newly selected interface, and begin operating on that interface.

Connection viaWi-Fi
To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be physically connected to the Dante network
(either to a network switch, or to a Dante hardware device). The Wi-Fi interface on the Dante Controller computer
must be connected to the Wi-Fi access point.

Example
In the example below, the computer running Dante Controller is connected via W-Fi to a Wi-Fi access point
connected to the primary Dante network.
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UsingWi-Fi andMulticast Transmit Flows

When using a Wi-Fi network connection between Dante Controller and your Dante network, any multicast transmit
flows configured in your network routing can flood the Wi-Fi link, and degrade the performance of the link.

You may be experiencing this condition if:

1. You are using a Wi-Fi network connection

2. You have multicast transmit flows in place

3. You observe speed or stability issues with your Wi-Fi connection

Remedial action
Remove or reduce the multicast traffic

The easiest way to remedy this condition is to either remove all multicast flows and use unicast flows instead; or,
reduce the amount of multicast bandwidth on the network by removing some multicast flows. There is no hard rule
that specifies how much multicast traffic is too much for a Wi-Fi link – the performance of the link is the best real-
world indicator.

If you are unable to remove or reduce multicast traffic, there are various ways to filter multicast media traffic from the
Wi-Fi link.

Filter multicast media at the access point

Depending on the type of Wi-Fi access point (or AP - typically, a W-Fi modem / router) that you have, it may
automatically block ‘unregistered’ multicast traffic, which is multicast traffic that hasn’t been specifically requested
by a network device. Because Dante Controller will never request to join a multicast media stream, the AP will never
send multicast media traffic (audio or video) to the Dante Controller computer.

It should however allow multicast control traffic – this is important for Dante Controller, because device discovery in
Dante uses a multicast control protocol.
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If the AP doesn’t automatically block unregistered multicast, you may be able to proactively filter it out using a ‘filter
multicast’ feature in the AP. The feature should filter the high-bandwidth multicast media traffic, but again should
allow multicast control traffic. Not all APs feature automatic multicast filtering, or a ‘filter multicast’ configuration
option. Refer to the user manual for your AP for more information.

Connect the AP to a dedicated control port on a Dante device

Some Dante hardware devices include a ‘control port’, which is a Dante Ethernet port that automatically filters
multicast media traffic. Control ports should be clearly marked as such on the device.

You can connect your AP to this port, which will enable Wi-Fi connectivity between Dante Controller and the
network, but the port will not pass multicast media traffic to the AP. Refer to the user manual for your device for more
information.

Enable IGMP snooping on the network switch

Enabling IGMP snooping on the network switch will block multicast media to all switch ports unless a device on that
port has specifically requested to join a multicast group (stream). This means that multicast media can flow between
audio and video devices but will not flow over the AP to Dante Controller. Refer to the user manual for your switch
for more information.
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UsingDanteController
Dante Controller presents two main types of view: Network View and Device View.

Important: After making changes to Dante network routing (e.g. subscriptions, device names, channel names
etc.) please wait at least 5 seconds before disconnecting or powering down any affected devices. This
ensures that the new information has been properly saved to the devices. Device configuration (e.g. sample
rates, latency, clock settings) are saved instantly.

Note: macOS users: Please note that the key combinations shown below are for Windows users. When using
Dante Controller on a Mac, use the “Command (CMD)” or “Apple” key instead of the “Control” key when
following the instructions below, and substitute standard Mac key combinations where applicable – see the
Dante Controller menu for details.

NetworkView
When Dante Controller is started, it opens at the Network View, with the Routing tab selected.

Note: For networks that include video (Dante AV) devices, see Routing for Video Devices
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Menu Bar

The menu bar in the Network View includes four menus: File, Device, View and Help.

File
n Load Preset (Ctrl+L): loads a configuration from a file

n Save Preset (Ctrl+S): saves configuration for currently displayed devices to a file

n Interfaces: Opens the Configure Dante Interfaces dialog

n Exit (Alt+F4): Exits Dante Controller

See Presets for more information.

Devices
n Refresh (F5): Refreshes the displayed network / device data

n Clock Monitoring: Toggles clock monitoring on/off

n Connect Devices to DDM / Dante Director

n Device View (Ctrl+D): Opens a new Device View window

View
n Dante Updater (Ctrl + U)

n Dante Activator (Ctrl + I)

n DDM / Dante Director Login (Ctrl + O)

n Language: Select the user interface language. Set to 'Auto' to use the default operating system language.

n Theme: Switch between light and dark mode. Set to 'Auto' to use the system default.

n Device scale: Switch between default and compact views for the routing pane. Use compact if you have a lot
of devices and want to see more on-screen.

n Show Filter Pane (Ctrl + Shift + F)

n Show/Hide Channel Groups (Ctrl + Shift + G)

n Show Hidden Devices (Ctrl + E)

n Swap Routing View Axes: Switch between Receivers on the left and Transmitters on the top, or Transmitters
on the left and Receivers on the top.

Help
n About: Shows the Dante Controller version, and current event log file location

n Show License: Displays the license text

n Check for updates: Checks the update server for new Dante Controller versions

n Analytics: Disable / enable analytics data collection

n Feedback: Opens your default browser at the Audinate Product Feedback form

n Online Help (F1): Opens this HTML user guide on the Audinate web server (requires an Internet connection)

n Offline Help: Opens a locally-stored PDF of this user guide (may not be the latest version of the user guide)

Tool Bar

Below the menu bar there is a tool bar, containing these buttons:

Dante Activator.htm
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Filter pane Shows / hides the advanced filter pane.

Reload Device Information Updates the current view with the latest device information
from the network. This is useful when a recent change to the
network has not yet propagated automatically through to
Dante Controller (for example, a new device has been
added to the network).

Load Preset Loads a previously saved media routing configuration. See
Presets for more information.

Save Preset Saves the current media routing configuration. See Presets
for more information.

Choose a Dante Interface Opens the Configure Dante Interfaces dialog. See
Configuring Dante Controller for more information.

Clock Monitoring Activates the Clock Status Monitoring function. See Clock
Status Monitoring for more information.

Channel Groups Activates channel groups. See Channel Groups for more
information.

Dante Updater Launches Dante Updater.

Dante Activator Launches Dante Activator.

Domain Manager Login Enables connection to a Dante Domain Manager server.

To the right of the toolbar, Dante Controller displays the current Primary Leader clock (or clocks, in the case of
redundant networks or DDM networks).

To the right of the clock display is the currently-selected domain, and the currently logged in DDM user (when
logged into Dante Domain Manager).

Tabs

Click the tabs below the tool bar to view:

n Routing

n Device Info

n Clock Status

n Network Status

n Events

The use of each of these tabs is described in the next section.

Dante Activator.htm
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Status Bar

The Status Bar displays notifications for network status, general device events, and clock status events, plus the
current Dante media multicast bandwidth on the network.

DDM Networks

In DDM networks, the devices displayed in the Network View will vary according to the selected domain. See
Viewing Domains in Dante Controller for more information.

When logged into a domain that includes legacy (pre-v4.0 firmware) devices, those devices are displayed with gray
highlighting instead of blue.

Shared devices are displayed with green highlighting and green text. See the DDM user guide for more information
about sharing audio in DDM networks.

StatusBar

The Status Bar displays the following information:

n P: The current status of the Primary network. Green indicates that Dante Controller is currently connected to
the primary Dante network. Red indicates a problem with the connection.

n S: The current status of the Secondary Dante network. Only displayed where a secondary network is con-
nected.

n The number of discovered devices on the network

n Multicast Audio Bandwidth: The current Dante audio multicast bandwidth on the connected networks for
unmanaged (un-enrolled) devices. Note that there may be network traffic from other sources that is not
included in the multicast bandwidth reading.

n Event Log: Indicates the current status of the event log. Click the icon to open the Events View.

n Clock Status Monitor: Indicates the current status of the Clock Status Monitor. Click the icon to open the
Clock Status Monitor.

NetworkViewTabs

Routing View

When Dante Controller is started, it always displays the Routing Tab within the Network View. In this view the
network is shown in the form of a grid. Devices with Tx channels are displayed along the top row of the grid, and
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those with Rx channels are displayed along the left-hand column of the grid. Initially a collapsed view is presented;
individual channels cannot be seen.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an error
condition. Double-click the device name to see more information. Refer to Automatic Notification of Device
Errors for further explanation.

Note: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also along the left-
hand edge.

Expanding the Routing View

The Rx channels associated with any device can be displayed by clicking on the [+] to the left of the device name in
the left-hand column of the grid. The Tx channels associated with any device can be displayed by clicking on the [+]
above the device name on the top row of the grid. When this action is performed the grid view expands to show each
channel of the device, and the [+] becomes a [-]. Clicking on [-] collapses the view. You can also group channels into
sets of 16.
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The Rx channels associated with all devices can be simultaneously expanded by clicking on the [+] of “[+] [-] Dante
Receivers” at the top of the left-hand column. Similarly, the Tx channels associated with all devices can be
simultaneously expanded by clicking on the [+] of “[+] [-] Dante Transmitters” at the left of the top row. Clicking on [-]
will collapse the view.

Note: Devices and channels that support Media Encryption are identified with special icons.

You can switch between default and compact routing grid sizes via the View menu, and also swap the routing
view axes (to show Transmitters on the left and Receivers on the top, instead of the default arrangement).

Device Name Text Colours
Device names by default appear in black text (in light mode) or white text (in dark mode).

However they may also appear in:

n Green text, which indicates a 'virtual device' shared via DDM

n Orange text, which indicates a warning state (for example, in upgrade mode)

n Red text, which indicates an error state (for example, in fail-safe mode)

n Blue text, which indicates RTP transmit flows (AES67 or SMTE 2110 audio)

Device List Filtering

The device lists in the Routing view can be filtered using the 'Filter Transmitters' and 'Filter Receivers' boxes, below
the Dante logo in the top left-hand corner. Any text string typed into the box will filter the view to only display devices
that contain that text string, in either a device name, or channel name.

The filtering is case-insensitive. For example, in the Dante Controller Network view shown here, entering the string
“foh” in either of the Filter fields would display only the FOH-Amp and FOH-Console devices, and their channels.

See also: Advanced Filter

Advanced Filter

About the Advanced Filter
The Advanced Filter can be used to filter the devices displayed in the Network View Routing, Device Info, Clock
Status and Network Status tabs.
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Use the Advanced Filter to easily locate or display devices with specific names, channel names, states or
configuration parameters.

To open the advanced filter, click the sidebar button:

Filter groups (including the text filter) are additive (AND logic, not OR logic). The devices displayed are those that
match all specified conditions. For example, entering ‘amp’ in the text filter and selecting ‘48k’ in the Sample Rate
filter will display all devices with the ‘amp’ string in the device name (or receive channel names) which are also set to
48kHz sample rate.

Inside a filter group, selections use OR logic. For example, selecting ’44.1k’ and ‘48k’ in the Sample Rate filter will
display all devices set to either of those sample rates.

Text Filter
The text filter displays devices with device names or receive channel names that match the text string entered into
the Search field.

The device name filter is case-insensitive (capitalization is ignored), and allows alphanumeric characters (a-z, 0-9)
and the hyphen character (-). Wildcards are not supported.

To clear the device name filter, just delete the text in the Search field, or click the Clear All button.

Device State and Configuration Filters
The device state and configuration filters can be expanded and collapsed using the plus [+] and minus [-] icons.

To filter devices for a particular condition or set of conditions, just select the required checkbox or combination of
checkboxes.

Use the Clear All button to clear the selections from all filters.

Device Lock Filter



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -52-

Use the Device Lock filter to display devices with a specific lock state.

n To display only locked devices, select the 'Locked' checkbox.

n To display only unlocked devices, select the 'Unlocked' checkbox.

n To display locked and unlocked devices, select both the 'Locked' and 'Unlocked' checkboxes.

n To display devices that do not support Device Lock, select the 'Unsupported' checkbox.

Sample Rate Filter

Use the Sample Rate filter to display devices with a specific sample rate setting.

n To display only devices with a particular sample rate, select the appropriate checkbox.

n To display only devices with one of a selection of sample rates, click the appropriate checkboxes.

Media Type Filter

Use the Media Type filter to display devices with specific channel types.

n To display only devices with video channels, select the 'Has Video Channels' checkbox.

n To display only devices with audio channels, select the 'Has Audio Channels' checkbox.

n To display only devices with ancillary channels, select the 'Has Ancillary Channels' checkbox.

n To display devices with a mix of channel types, select the appropriate checkboxes.

Video Subtype

Use the Video Subtype filter to display devices with the selected video format(s).

Ancillary Type

Use the Ancillary Type filter to display devices with specific ancillary channel types.

n To display only devices with USB channels, select the 'USB' checkbox.

n To display only devices with serial channels, select the 'Serial' checkbox.

n To display only devices with IR channels, select the 'IR' checkbox.

n To display devices with a mix of channel types, select the appropriate checkboxes.

Sync to External

Use the Sync to External filter to display devices with a specific Sync to External setting.

n To display only devices with Sync to External enabled, select the 'Enabled' checkbox.

n To display only devices with Sync to External disabled, select the 'Disabled' checkbox.

n To display devices with either setting, select the 'Enabled' and 'Disabled' checkboxes.

n To display devices that do not support Sync to External, select the 'Unsupported' checkbox.

Latency

Use the Latency filter to display devices with a specific latency setting.

n To display only devices with a particular latency, select the appropriate checkbox.

n To display only devices with one of a selection of latencies, click the appropriate checkboxes.

Subscriptions

Use the Subscriptions filter to display devices with a specific subscription state.

n To display only devices with no subscriptions, click the 'None' checkbox.

n To display only devices with one or more successful subscriptions, click the 'Has Successes' checkbox.

n To display only devices with subscription warnings, click the 'Has Warnings' checkbox.

n To display only devices with subscription errors, click the 'Has Errors' checkbox.
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Note: ‘Success’ will not only display devices with only successful subscriptions – it will also display devices with a
mix of successful and failed subscriptions. Similarly, ‘Failure’ will also display devices with a mix of failed and
successful subscriptions.

Tx Multicast Flows

Use the Tx Multicast Flows filter to display only devices with Tx Multicast Flows configured.

n To display only devices with one or more Tx Multicast Flows configured, select the 'Active' checkbox.

AES67

Use the AES67 filter to display devices with a specific AES67 setting.

n To display devices with AES67 enabled, select the 'Enabled' checkbox.

n To display devices with AES67 disabled, select the 'Disabled' checkbox.

n To display devices with either setting, select the Enabled and Disabled checkboxes.

n To display devices that do not support AES67, select the 'Unsupported' checkbox.

Sample Rate Pull-up

Use the Sample Rate filter to display devices with a specific sample rate pull-up setting.

n To display only devices with a particular pull-up, select the appropriate checkbox.

n To display only devices with one of a selection of pull-ups, click the appropriate checkboxes.

ChannelGroups
When Channel Groups is active, device channels in the Network View Routing tab are grouped into sets.

This makes it easier to view and make channel subscriptions for devices with large numbers of channels, such as
PCIe cards.

To activate it, click the Channel Groups button in the Network view toolbar:

By default, the groups are named 1..16, 17..32 etc. - however, some devices may use custom grouping
configurations.
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To expand a channel group, click the plus [+] icon. To collapse a channel group, click the minus [-] icon.

Note: Grouping channels does not affect routing or device behaviour.

Device Info

The Device Info tab provides a network-wide overview of device configuration and operating information. For DDM
networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:
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n Device Name: The device name currently associated with the device

n Model Name: The model name of the device

n Product Version: The product version assigned by the manufacturer

n Dante Version: The firmware version for hardware devices, or software version for Dante software applic-
ations

n Device Lock: The lock state of the device. You can also click this field to open the device lock / unlock dialog.

n Product Version: The product version, as defined by the manufacturer

n Primary Address: The IP address assigned to the primary interface.
IP addresses are currently assigned via DHCP, or automatically self-assigned. Self-assigned addresses on
the primary interface will be in the 169.254.*.* range.

n Primary Link Speed: The Ethernet link speed of the primary interface

n Secondary Address: The IP address assigned to the secondary interface.
Self-assigned addresses on the secondary interface will be in the 172.31.*.* range. 'N/A' indicates that the
device does not support a secondary interface. 'Link down' indicates that the device supports a secondary
Dante interface, but it is not currently connected.

n Secondary Link Speed: The Ethernet link speed of the secondary interface. Other values are possible (as
per Secondary Address)

Note: A Dante interface may have a preferred link speed. Where it does, and an interface is not operating at
that preferred link speed, the values in the Link Speed columns will be shown in red.

Note: If no device information is displayed for a device, it can indicate a ConMon (Dante control and
monitoring service) failure on the device. The device may need to be reset or restored.

Clock Status

The Clock Status tab provides a network-wide overview of the clocking state within the network.
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This view provides a convenient way of quickly scanning the network for clock information. For DDM networks,
devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

Device Name
The device name currently associated with the device.

Sync
Indicates the clock sync status for the device.

n A green light  indicates that the device is currently synced to (or is driving) the network clock

n A red light  indicates that the device is not currently synced

Mute
Indicates the mute status for the device.

n
A red mute icon  indicates that the device is currently muted (usually due to loss of clock sync)

n No icon in the mute column means that the device is not muted (audio should be flowing normally)

Clock Source
Indicates the clock source for the device.

n Dante: The device is deriving its clock from the Dante network, or is acting as leader clock (but not deriving its
clock from an external source)

n External: The device is deriving its clock from an external word clock source

Domain Status (DDM networks only)
Indicates the clock's role for its domain.

n Leader: The device is the leader clock for the domain.

n Follower: The device is a boundary clock follower (receiving unicast PTP from a domain leader in a different
subnet).

n Standby: The device is a backup boundary clock.

n Disabled: The device does not currently have a domain clocking role.

n N/A: The device cannot act as a boundary clock.

See the DDM user guide for more information about domain clocking.

Primary v1 Multicast
Indicates the state of the PTP v1 (Dante audio) clock for the primary interface. Routed DDM networks will indicate a
leader clock for each IP subnet.

n Leader: Device is the current PTP v1 Leader Clock on the primary Dante network

n Follower: Device is a PTP v1 Follower on the primary Dante network

n Passive: Device is not using clock synchronization information from this interface

n Link Down: The interface is not connected to the network

n N/A: Indicates that the device does not support clock status reporting. In the Secondary Status column, can
also indicate that the device is non-redundant.

n Listening: Usually transient. When persistent, it indicates that the device can not operate as a clock leader
(follower only), and is waiting for a clock leader to appear on the network.
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Devices that are configured with sample rate pull-up/down are shown with the relevant pull-up/down value against
their Clock Status. For example, a device acting as leader clock with +0.1% pull-up will be shown as Leader
(+0.1%). See About Clock Domains for more information.

Other transient clock states exist, which are not listed above.

Primary v2Multicast
Indicates the state of the PTP v2 clock for the primary interface, for AES67 or SMPTE-enabled devices. Possible
states are identical to those for Primary v1 Multicast.

Secondary v1 Multicast
Indicates the state of the PTP v1 (Dante audio) clock for the secondary interface. Possible states are identical to
those for Primary v1 Multicast.

Secondary v2Multicast
Indicates the state of the PTP v2 clock for the secondary interface, for AES67 or SMPTE-enabled devices. Possible
states are identical to those for Primary v1 Multicast.

PTPv2 Domain Number
Indicates the PTPv2 domain number for devices with PTPv2 enabled (for example, devices configured for
RTP support).

PTPv2 Priority 1 / Priority 2
Indicates the PTPv2 priorities for devices with PTPv2 enabled (for example, devices configured for RTP support).

Preferred Leader
Raises the priority of the device in the leader clock election.

If only one device on a particular clock domain has this checkbox ticked, it ensures that the selected device
becomes leader clock (for that clock domain). When multiple devices have their Preferred Leader checkbox ticked,
the leader will be elected automatically from within that group.

If 'Follower Only' is shown instead of a checkbox, it indicates that the device is not capable of acting as a leader
clock.

Enable Sync To External
Forces the Dante module to derive its clock from an external source - either from a host device word clock, or from
an auxiliary device.

This will also ensure that this Dante device becomes leader clock for the relevant clock domain (unless another
device has 'Preferred Leader' selected). It is not normal practice to configure more than one device per clock
domain with an external clock source. In this case, the user is assumed to have synchronized external word clock
sources (e.g. house clock).

Where the checkbox is present but greyed-out (and inactive), it means that the Dante device can be follower to an
external word clock, but it cannot be set directly from Dante Controller - it must be done via the host device user
interface, or via some other method (e.g. third-party control software). If the checkbox is greyed out and populated,
it means that the Dante device is currently following the external clock.

If N/A is displayed, it means that the device does not support slaving to an external word clock.
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Note: If no clock status information is displayed for a particular device, it can indicate a ConMon (Dante
control and monitoring service) failure on the device. The device may need to be reset or restored.

About Clock Domains

By default Dante uses the PTPv1 protocol to sync devices.

Dante Devices that are not configured with sample rate pull-up/down operate on the default clock domain, using the
default clock. Devices that are configured with sample rate pull-up/down operate on separate 'clock domains', which
have their own dedicated PTP clocks, adjusted to account for the pulled up/down sample rates.

Clock domains are not physically separated, they all exist on the network simultaneously. Devices with pull-up/down
synchronize to the appropriate clock for their pull-up/down setting, and ignore other clocks. Those devices are
shown with the relevant pull-up/down value against their Clock Status in the Clock Status tab.

Dante devices that support AES67 and ST2110 also use PTPv2 clock domains. In some cases PTPv1 can be
disabled and only PTPv2 is used.

Dante devices can only transmit media to, and receive media from other devices on the same clock domain
(whether that is PTPv1 or PTPv2). For example, a device with zero sample rate pull-up/down operates on the
default clock domain, and cannot transmit media to, or receive media from any devices on the +4.1667% clock
domain, or the -1% clock domain, etc.

Up to 5 separate clock domains can be supported at any one time. All clock domains have their own leader clock.

In DDM Networks
In DDM networks, each Dante domain typically uses its own special clocking domain (except in the case of media
sharing between domains, when multiple Dante domains will share the same clock domain).

About Leader Clocks

The Dante network leader clock (often also referred to as the 'Primary Leader'), is displayed at all times in the center
of the toolbar of the Network View. This is the device that is providing the time sync source for all devices on the
network.

If multiple clock domains are in use, the leader clock for each domain is shown, in a comma-separated list.

The leader clock is chosen automatically through an election process, though there are user configurable
parameters that allow prioritization of some devices in the leader clock election. Configuring a device to have an
external word clock source will force that device to become leader clock, unless another device has 'Preferred
Leader' set.

Checking the 'Preferred Leader' flag will always result in that device (or the device with the lowest MAC address, if
more than one device has been checked) becoming leader clock for that domain.

Note: If the leader clock device is not directly visible to Dante Controller (for example, if the leader clock
device is for some reason only connected to the secondary network, and Dante Controller is only connected to
the primary network), the 'Leader Clock' display in the toolbar may show a MAC address string, instead of the
device name.
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ClockStatusMonitoring
Dante devices are monitored by Dante Controller to establish the status of their clock synchronization with the
Dante network leader clock.

There are two levels of monitoring: 'passive' and 'active'.

In passive mode, Dante Controller will report if a clock loses sync (or regains sync) with the leader clock.

In active mode, Dante Controller will also report if a clock is showing signs of instability. If a device clock is
significantly unstable, it can lose sync with the leader clock, which will result in the device being automatically
muted.

Whywould a device clock be unstable?
There are a range of network conditions that can interfere with a device’s clock stability. These include:

n A switch on the network is configured to use Energy Efficient Ethernet ('Green Ethernet') functionality

n A 100 Mb switch or link is present where a Gigabit connection is required

n One or more switches are incorrectly configured

n A 'problematic' external word clock is being used as the leader clock

Refer to the Dante FAQs for more information.

Passive monitoring

Passive monitoring is on all the time. If a Dante device loses sync with the leader clock, or regains sync with the
leader clock, it reports the event to Dante Controller. Dante Controller records these events in a log file, and also will
display an alert: the Clock Status Monitor icon (at the bottom right corner of the main window) will light up red.

Clicking the icon opens the Clock Status Monitor, which includes the clock status event log, and a clock status
histogram.

ActiveMonitoring

When active monitoring is switched on, Dante Controller begins actively monitoring the behaviour of supported
devices to identify signs of clock instability. If a clock exhibits significant instability, the Clock Status Monitor icon will
light up amber, and a warning event will be recorded in the clock status event log.

Click the icon to open the Clock Status Monitor.

Active monitoring is off by default. To activate it, click the Clock Status Monitoring button on the main toolbar:

When Active Clock Status Monitoring is active, the button is highlighted.

https://www.getdante.com/support/faq/
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To switch it off, click the button again.

Note: Active monitoring does not affect passive monitoring.

Which devices are supported?
Dante PCIe cards, Dante-MY16-AUD cards, Ultimo (low channel count) devices and devices that include a
'Brooklyn II', 'Broadway' or 'HC' Dante module support active monitoring.

Check the Dante Model value in the Dante Information section of the Device View > Status tab to identify your
device type.

ClockStatusMonitor
The Clock Status Monitor includes two tabs, Log and History.

Log

The Clock Status log shows time-stamped clock status events for each device that has been identified as unstable,
or has lost or regained sync with the leader clock.
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The event types are:

n Clock Sync Warning: Indicates that a clock has been identified as unstable, and is at risk of losing sync with
the leader clock

n Clock Sync Unlocked: Indicates that a device has lost sync with the leader clock. This will result in the device
being automatically muted until it regains sync.

n Clock Sync Locked: Indicates that a device has regained sync with the leader clock.

n Audio Mute: Indicates that a device was muted.

n Audio UnMute: Indicates that a muted device was un-muted.

To delete all Clock Status log entries, click Clear . This will reset the Clock Status Monitor icon to green.

Note: This will also clear all other event log entries (the Clock Status log is a filtered view of the main event
log).

Dante Controller will then resume monitoring (unless the Clock Status Monitoring button is switched off).



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -62-

To save the event log as an xml file, click Save.

History

The History tab can be used to establish the stability of device clocks. It shows a histogram of clock frequency offset
for the selected device, and the current frequency offset value, updated in real time.

The following information is also displayed:

n Mute status

n Sync status

n External word clock

n Preferred leader status

About Clock Offset
Hardware clocks are based on a vibrating (piezoelectric) quartz crystal. All crystals are slightly different, and vibrate
at slightly different frequencies. When a device ('follower') clock wants to sync to a leader network clock, its
frequency must be 'pulled' up or down to match the frequency of the leader clock. The amount that the clock's
frequency is pulled is referred to as 'offset'.

Hardware clocks can only support a certain amount of offset, referred to as 'pull range'. If the pull range is exceeded,
the follower clock will lose sync with the leader clock, and the device will be automatically muted.

Software clocks typically use an algorithm to derive a clock from an internal counter. Software clocks can support
any amount of offset.

Rapidly-changing offset can also cause a follower clock to lose sync with the leader clock.

Various factors can destabilise follower clocks by affecting their offset, such as:

n Overloaded network links

n Poorly-implemented EEE (Energy Efficient Ethernet)

n A leader clock that is derived from an inaccurate external word clock (one that does not run at its nominal fre-
quency)

About the Histogram
The horizontal axis of the histogram shows the distribution of clock frequency offset measurements against the
nominal frequency of the clock, in parts per million (ppm). The zero point of the horizontal axis corresponds to the
clock's nominal frequency (i.e. the frequency that the clock is intended to run at - for example, 98kHz).

The vertical axis shows the number of measurements recorded at each data point, on a logarithmic scale.
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The histogram is continually updated, with measurements taken roughly once per second.

n To select devices, click the drop-down menu at the top .

n To clear the histogram, click Clear.

n To save a png format screenshot of the current data, click Save.

Interpreting the Histogram
The histogram can be seen as an indication of how much work a follower clock is doing to stay in sync with the
leader clock.

Generally, a stable and accurate clock will show consistently stable offset (with variation in the order of a few ppm).
It means that it is not having to change its offset very much to stay in sync.

Show me
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A histogram that shows a distributed range of offsets indicates an unstable clock - it is having to change its offset
significantly, and often, to stay in sync with the leader clock. This can be due to overloaded network links, or poorly-
implemented EEE. A device in this state is highly likely to lose sync with the leader clock.

Show me

A histogram that shows measurements in amber and/or red indicates a clock that might be currently stable, but has
little room for manoeuvre; its offset could easily move outside its pull range, at which point it will lose sync
completely. This can result when the leader clock is derived from an inaccurate external word clock.
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Note: Dante Controller can be left running for a few days (or even weeks) to collect clock status data,
providing a long-term picture of the stability of your network clocking configuration.

Show me

Network Status

The Network Status tab provides a range of network-related information across all devices in the network.

This view includes subscription status, bandwidth and latency information, and can be used to quickly identify any
potential network traffic issues. For DDM networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

Device Name
The device name currently associated with the device.
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Subscription Status
The icon in the Subscription Status column displays a summary of subscription states for the device. If any of the
device's channels are not successfully subscribed, the relevant icon will be displayed here.

See Subscribing to Audio Channels for information about the various icons that can be displayed in the Subscription
Status column.

Primary Status
The Primary Status column indicates the link speed of the primary Dante network interface for the device.

Secondary Status
The Secondary Status column indicates the link speed and status of the secondary Dante network interface for the
device (if applicable). 'N/A' indicates that the device does not have a secondary interface. 'Link Down' indicates that
the device has a secondary interface, but it is not currently connected.

Bandwidth Columns
Use the bandwidth columns to see an approximation of transmit and receive traffic over individual device interfaces.

n Primary Tx B/W

The Primary Tx B/W column displays an approximation of the current transmit bandwidth on the primary
Dante network interface for the device.

n Secondary Tx B/W

The Secondary Tx B/W column displays an approximation of the current transmit bandwidth on the
secondary Dante network interface for the device.

n Primary Rx B/W

The Primary Rx B/W column displays an approximation of the current receive bandwidth on the primary
Dante network interface for the device.

n Secondary Rx B/W

The Secondary Rx B/W column displays an approximation of the current receive bandwidth on the
secondary Dante network interface for the device.

Latency Setting
Shows the current latency setting for the device.

Note: For video (Dante AV) devices, the latency setting applies only to the audio channels.

Latency Errors
The Latency Errors column displays icons representing the recent latency performance of the device.

 A green light indicates that the device is subscribed, and there are no latency problems - i.e. all audio

packets are arriving well within the device's latency setting.
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 An amber light indicates that audio packets for one or more channels are arriving at or near the limit of

the device's latency setting. You may need to increase the device's latency, or reconfigure the network to
prevent audio glitches due to packet loss from late-arriving audio packets.

 A red light indicates that one or more audio packets have arrived outside the device's latency setting.

This will result in audio glitches. The device's latency setting should be increased, or the network
reconfigured (for example, by reducing the number of network nodes in between the transmitter and the
receiver).

 A grey light indicates that the device is not currently subscribed.

Packet Errors
A red light in the Packet Errors column indicates that one or more media packets have been corrupted in between
the switch and the receiver. This is usually due to a faulty Ethernet cable.

Use the Clear Counters button in the Device View > Status tab to clear the packet errors history for a device.

Events

The Events tab provides information on significant changes and failures in the network.

Dante Controller continually monitors Dante devices and the network as a whole. It is able to watch for problematic
configurations, unexpected problems and communication failures between itself and Dante network devices.
Events are displayed and stored in an event log.

Events fall into one of three categories: Information, Warning and Error.

Filtering the Event List
Use the drop-down menu at the bottom left of the view to filter the events list.

n When set to Information, all events are shown.

n When set to Warning, only warning and error events are shown.

n When set to Error, only error events are shown.
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Clearing the Event List
To clear the event list, click the Clear button. When new events are detected that match the current filter setting,
they are displayed in the event list.

If you have switched to another Network View tab, new events in the event list will also be indicated by a red Event

Log LED icon in the Status Bar. Clicking the LED icon will take you straight to the Events tab and will clear the

Event Log LED.

Note: The Event Log LED icon will always remain green while the Events tab is open.

Saving the Event Log
To save the event list, click the Save button. The list is saved as a text file with file extension .log. All events in the
list are saved (the filter does not apply to saved events logs).

Automatic event logging
Events are also continuously written to a log file. Each time Dante Controller is started, it creates a new log file (with
a time-stamped filename, to avoid overwriting previous logs).

You can find the path to these log files under Help > About. To delete log files more than seven days old, click the
Delete old Log files button.

Event Classification
The following events are classified as Errors:

n Invalid link local address

n Subnet mismatch on dante interface

n Subnet match with non dante interface

n Multiple addresses with matching subnets

n Subnet conflict of dante interface on primary

n Subnet conflict of dante interface on secondary

n Unknown address error

n Fail Safe Mode

n Unknown device issue

n Elevation to Clock Leader

n Fanout Configuration detected

n Mismatched clock pullup subdomain

n Wrong subdomain for pullup

n Unknown subdomain

n Audio mute / Audio unmute

n Clock sync lock / unlocked

The following events are classified as Warnings:

n Resolution Failed

n Elevation to Primary Leader

n Multiple external clock sources
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n Cannot Elevate to Clock Leader

n Clock Sync Warning

The following events are classified as Information:

n Request Timeout Error

n Response Timeout Error

n Demotion from Clock Leader

n Demotion from Primary Leader

n Reboot required

AutomaticNotificationofDeviceErrors
Dante Controller is able to identify several types of problems that a Dante device may experience. A device that is
found to have problems will have its device name displayed in red. Additional information about the problem can be
found by double-clicking on the device.

A device displayed in red will either have entered failsafe mode, or will have an identified issue with its IP
configuration. These states are described in more detail below.

A device displayed in orange (’Ultimo’ low channel count devices only) will have entered upgrade mode (see
below).

Incorrect IP address configuration

Dante networks use IP Addressing to communicate. Incorrect address configuration can make it hard or impossible
for a Dante device to communicate. Dante Controller attempts to identify and report several types of incorrect IP
address configuration, including:

n Having multiple DHCP servers on the same network

n Incorrectly configured static IP addresses

n Connecting the secondary interface of a Dante device to the primary network

n Different interfaces on the same device using the same IP address subnet

n Configuring a DHCP server on the primary network to use the IP address range reserved for secondary link
local devices (172.31.*.*)

If you need further information, please refer to the Troubleshooting section.

Failsafe mode

A device will enter failsafe mode when the firmware image stored on the board has become corrupted. Although
rare, this can occur when:

n The firmware update process is interrupted by power loss or network failure

n The firmware image itself that was used in an upgrade is corrupt

If your device enters failsafe mode, please use the Failsafe Recovery function in the Firmware Update Manager
application (if available) or contact your device manufacturer.
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Upgrademode

When some devices (technically, those that include an internal Ethernet switch) are upgrading, or have finished
upgrading but have not yet been rebooted, they are in ‘upgrade mode’, and are displayed in orange text in Dante
Controller. While in this mode, an ‘Issues’ tab is visible in the Device View for the device, indicating their current
state.

When these devices have had new firmware applied, they must be ‘manually’ rebooted by the user, via Dante
Controller (unlike other devices which reboot automatically as part of the upgrade process). This is because any
daisy-chained Dante devices downstream of the upgraded device will not receive media or firmware update data via
that device while it is rebooting. The manual reboot option allows you to control when the device reboots, and thus
prevent:

n Interruption of media to any downstream daisy-chained devices until it is convenient, and

n Interruption of firmware update data to any downstream daisy-chained devices that are also in the process of
updating - which in some devices can lead to the update failing, and the device entering failsafe

When the device has rebooted, media flow to any downstream daisy-chained devices will resume automatically.

Other Event Notifications

Dante Controller will also notify you of network status, general device events and clock status events, via the LED
icons in the Status Bar.

DeviceView
The Device View is used to view and modify detailed information and settings for a specific device. Device view can
be activated by double-clicking a device name in any of the Network View tabs (except Events), or by selecting
Device View from the Device menu (Ctrl + D, or Command + D) in the Network View window. The Device View
opens in a new window. Multiple device views can be open simultaneously.

Note: macOS users: Please note that the key combinations shown below are for Windows users. When using
Dante Controller on a Mac, use the 'Command' or 'Apple' key instead of the Ctrl key when following the
instructions below, and substitute standard Mac key combinations where applicable – see the Dante Controller
menus for details.
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The name of the device being viewed is displayed in the middle of the toolbar. In the screenshot above, FOH-
Console is the device being displayed in the drop-down list box.

The device viewed can be changed by selecting another device from the drop-down list.

Multiple Device View windows may be opened from the Network View, so that several devices can be examined
simultaneously.

The Device View displays some or all of the following tabs, allowing you to see different information relating to a
specific Dante device:

n Receive: Display and configure device’s receive (Rx) channels

n Transmit: Display and configure device’s transmit (Tx) channels including multicast

n Status: Device software, clock and network status information

n Latency: View latency histograms (supported devices only)

n Device Config: Rename device, change sample rate and set other attributes (as relevant to device type)

n Network Config: View and edit network configuration

n Issues: Displays information for devices in failsafe mode, or upgrade mode (upgrade mode is used by ‘Ultimo’
low channel count devices only). Not usually visible.

n Baseboard: Only available when the Dante device is mounted on a Dante PDK audio baseboard (NOTE: the
device must be in SPI master mode)

There are also dedicated configuration tabs displayed only for specific devices.
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Device ViewMenu bar

The menu bar in the Device View contains the following menus:

File
n Close Window

Devices
n Refresh: Refreshes the displayed network / device data

n Create Multicast Flow

n Identify: Identify the current device by, for example, causing its LEDs to flash.

n Lock / Unlock

n Clear Domain Credentials

View
n Show/Hide Channel Groups

n View Flow Information

Help
n About: Shows Dante Controller version and current log file

n License: Displays the license text

n Online Help: Opens this HTML user guide on the Audinate web server (requires an Internet connection)

n Offline Help: Opens a locally-stored PDF of this user guide (may not be the latest version of the user guide)

Device View Toolbar

The Device View toolbar contains the following buttons:

Refresh Re-load routing and configuration information
for the current device.

Web Config Some Dante devices can be configured via a
web interface. This button opens a web
browser window which can be used to
perform functions such as firmware upgrades.
This feature is not supported on all Dante
devices.

Identify Identify the current device by, for example,
causing its LEDs to flash. Note that this
feature is not supported on all Dante devices.

Multicast Configure multicast transmit flows on the
current device.
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Channel
Groups

Activate / deactivate Channel Groups.

Device Lock Lock / unlock the device.

The toolbar also provides a drop down list of all available devices on the network, which allows you to switch the
Device View to a different device.

DeviceViewTabs
The Device View is split into tabs, some of which are only applicable to certain devices. Each tab is described in
detail below.

Receive Tab

The Receive tab displays a list of all subscribed and dormant receive channels on the current device, plus
subscription information for the subscribed channels. It also allows the creation of subscriptions from the Available
Channels list.
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The tab is split into two panes: Receive Channels, and Available Channels.

Receive Channels
The Receive Channels pane contains three columns:

n Channel: Lists the receive channel names for the current device. These can be edited here to rename the
channel.

n Connected To: Lists the Tx channel that the receive channel is currently subscribed to, plus the status of both
primary and secondary subscriptions, using the following icons:

Subscription is OK and media should be flowing

Subscription is unresolved - usually because the transmitting
device has been removed from the network, or is switched off

No subscription, or a subscription error
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Subscription is via unicast connection

Subscription is via multicast connection

Subscriptions can show several symbols in the Status column. Common status icon combinations and their
meanings are as follows:

Unicast device successfully subscribed to a transmitter

Redundant device successfully subscribed on both
primary and secondary via unicast

Redundant device successfully subscribed on both
primary and secondary via multicast

Redundant device successfully subscribed on primary
only via unicast. This is typically seen when the
secondary interface is not connected

Note: Additional icons are used for devices that support Media Encryption.

n Signal: Supported devices will also show the following channel metering icons, indicating the presence of
audio on subscribed channels:

Grey: Channel is either muted, or receiving audio at less than -
61dbFS

Green: Channel is receiving audio between -61dbFS and 0dfFS

Red: Channel is clipping

For video, ancillary and privately-encoded audio channels, supported devices may also show variations of the
following status icons in the Signal column:

The signal path (across the network) is good, and there are
no external connectivity problems detected

The signal path is good, but Dante Controller cannot
ascertain if there are any external connectivity problems

The signal path is good, but the Rx device does not support
the signal (for example, because the signal is HDCP and
the Rx device is not HDCP-enabled)

Indicates a signal problem such as an incompatible video
codec, or the Dante subscription is unresolved. Refer to
the subscription status icon for further information.
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The signal path is good, and the signal is encrypted

Available Channels
The Available Channels pane lists the devices and advertised channels available on the network. Devices that are
greyed out indicate that this receiver cannot subscribe to those channels or devices. This is typically because of a
mismatch in parameters (e.g. sample rate incompatibility etc.), or because a device cannot route media to itself.

For devices with many channels, you can click the Channel Groups  button to group available channels into

sets of 16.

AES67 Flows

‘Devices’ with multicast IP address names (e.g. 239.69.82.194) are actually AES67 flows, which can only be
received (or transmitted) by AES67-enabled devices.

Note: If they are displayed in blue, the currently-selected device is AES67-enabled, and can receive AES67
flows. If they are displayed in grey, the currently-selected device is not AES67-enabled.

Creating Subscriptions
Subscriptions are created by selecting a channel from the Available Channels list in the right-hand pane of the
Receive Tab, then dragging and dropping it onto the appropriate receive channel in the left-hand pane of the
Receive Tab.

Multiple channels can be selected and then dragged and dropped onto the Receive Channels pane, to make
several subscriptions simultaneously. You can also drag and drop channel groups to make bulk subscriptions.

Changing Receive Channel Names
To change a receive channel name, click the name and type in the new value.

Copying and Pasting Subscriptions and Channel Names
In the Receive tab you can copy subscriptions and channel names from one device to paste into another device.

To copy subscriptions or channel names, you can:

n Right-click one item and choose 'Copy'

n Shift-click to select a range of items, then right-click and choose 'Copy'

n Ctrl-click (Windows) or Command-click (macOS) to select multiple items, then right-click a highlighted item
and choose 'Copy'

n Right-click and choose either 'Select Row(s)' or 'Select Column(s)', then right-click a highlighted item and
choose 'Copy' to copy the entire row or column

n Right-click anywhere in the Receive Channels panel and choose 'Copy Entire Table'

You can also use Ctrl-C (Windows) or Command-C (macOS) to perform the copy after selecting items.

To paste the copied items into a new device, right-click where you want to paste the copied items and select 'Paste'
(or use Ctrl-V or Command-V). You will see a pop-up dialog to confirm the changes.

You can also paste the copied data into a text file or spreadsheet.

AES67 Config.htm
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The Signal column can be copied, but only pasted into a text file or spreadsheet.

Transmit Tab

The Transmit tab is used to inspect and modify the transmit configuration of a device.

The Transmit Tab is arranged in two areas:

n Transmit Channels: The area on the left pane of the tab shows the Tx channels for the device. It allows you
to edit channel names for transmit channels. Input to the table is filtered to prevent illegal characters from
being used in channel names.

Supported devices will also show the following channel metering icons in the Signal column, indicating
the presence of audio on subscribed channels:

Grey: Channel is either muted, or receiving audio at less than -
61dbFS

Green: Channel is receiving audio between -61dbFS and 0dfFS

Red: Channel is clipping
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For video, ancillary and privately-encoded audio channels, supported devices may also show the following status
icons in the Signal column:

Indicates there are no external connectivity problems with the Tx
device

Indicates there is an external connectivity problem with the Tx
device

Dante Controller cannot ascertain if there are any external
connectivity problems with the Tx device

n Multicast Transmit Flows: The area on the right pane of the tab shows the multicast transmit flows that have
been configured on the device.

Multicast flows are listed in ID order, including the channels contained within the flow. AES67 and
SMPTE multicast flows are identified as 'RTP' multicast flows, and also include the destination IP address for
the flow.

Note: Unicast flow details are displayed in the Flow Information dialog.

Changing Tx channel Names
To change a Tx channel name double click on the name and type in a new one. Tx channel names must be unique
for the device.

Copying and Pasting Channel Names
In the Transmit tab you can copy channel names from one device to paste into another device.

To copy channel names, you can:

n Right-click one item and choose 'Copy'

n Shift-click to select a range of items, then right-click and choose 'Copy'

n Ctrl-click (Windows) or Command-click (macOS) to select multiple items, then right-click a highlighted item
and choose 'Copy'

n Right-click and choose either 'Select Row(s)' or 'Select Column(s)', then right-click a highlighted item and
choose 'Copy' to copy the entire row or column

n Right-click anywhere in the Transmit Channels panel and choose 'Copy Entire Table'

You can also use Ctrl-C (Windows) or Command-C (macOS) to perform the copy after selecting items.

To paste the copied items into a new device, right-click where you want to paste the copied items and select 'Paste'
(or use Ctrl-V or Command-V). You will see a pop-up dialog to confirm the changes.

You can also paste the copied data into a text file or spreadsheet.

The Signal column can be copied, but only pasted into a text file or spreadsheet.

Status Tab

The Status tab is used to obtain current information about a Dante device.
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The tab is divided into sections. The information presented on this tab can be very useful when investigating

networking or clocking issues in the system. The Refresh button can be used to update this information if

required.

Note: Not all Dante devices support the display of all of this information.

Device Information
This provides the following general information about the device:

n Manufacturer: The name of the device manufacturer.

n Product Type: The type of device.

n Product Version: The product version.

n Software Version: The version of the manufacturer software running on the device.

n Firmware Version: The version of the manufacturer firmware running on the device.

Dante Information
This provides Dante-specific information about the device:
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n Model: The Dante device type.

n Dante Firmware Version: The version of the Dante firmware running on the device.

n Hardware Version: The version of the hardware firmware running on the device.

n ROM/Boot version: The version of the ROM or bootloader.

Clock Synchronization
This provides the following information about device clocking:

n Mute Status: 'Muted' indicates that the device is has been automatically muted (due to a clock syn-
chronisation problem, or because the external word clock is invalid). 'Unmuted' indicates that the device is not
muted, and audio is flowing normally.

n Sync Status: 'Locked' indicates that the device is locked to the network PTP clock. 'Not Locked' indicates that
the interface has not achieved lock with the network PTP clock.

n External Word Clock: 'No' indicates that the device has been configured to use the internal clock source.
'Yes' indicates that the device has been configured to accept an external word clock source. NOTE: If the
Dante device is configured to accept an external word clock source, it is important to make sure that the host
equipment has been configured to provide its word clock to the Dante device. Check your product manual for
more information.

n Preferred: 'No' indicates that the card has not been set to preferred leader mode. 'Yes' indicates that the card
is set to preferred leader mode.

n Frequency Offset: Indicates the offset from the network clock leader measured in parts-per-million.

Primary Interface
Provides the following information about the primary network interface:

n IP address: The IP address currently assigned to the interface

n MAC address: The Media Access Control address of the interface, associated with the Ethernet layer

n Tx Utilization: Shows the current total transmit bandwidth in use

n Errors: (on the same line as Tx utilization) shows the number of transmit Cyclic Redundancy Check (CRC) or
packet errors detected since the device was last started

n Rx Utilization: Shows the current total receive bandwidth is use

n Errors: (on the same line as Rx utilization) shows the number of receive Cyclic Redundancy Check (CRC) or
packet errors detected since the device was last started

Note: The Rx Utilization includes not only network traffic destined for the Dante device, but any other
multicast or broadcast traffic received at this network interface.

Note: As a rule of thumb neither the Rx nor the Tx utilization should exceed about 85% of the link speed in
order to guarantee good clock synchronization performance (links are full duplex).

The graphic also indicates the speed and connected state of the interface as follows:
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Indicates that the link is operating at 1Gbps

Indicates that the link is operating at 100Mbps

Indicates that the link is not connected, or that there is an
error. The IP address will read N/A, and Tx and Rx
utilization will be 0 kbps.

Clear Counters: Click this button to reset the packet errors history for the device.

Secondary Interface
This provides the same information for the secondary interface that is provided for the primary interface, as
described above.

Note: The secondary network interface will only be displayed if the device supports redundancy.

Latency Tab

For supported devices, the Latency tab displays histograms of audio packet latency for each transmitter that the
device is subscribed to.

Note: For video (Dante AV) devices, latency settings made in Dante Controller apply only to the audio
channels.

Which devices support latency monitoring?
Newer Brooklyn II, Broadway, HC, PCIe and Ultimo devices support latency monitoring in Dante Controller. You can
check your device type in the Device Info tab.
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About Latency and Packet Loss
Latency is used to account for the delay between an audio packet leaving the transmitter, traversing the network
(potentially through multiple switches) and reaching the receiver.

If a receiver's latency setting is too low, audio packets will not have time to get from the transmitter to the receiver
before they are supposed to be played out. When this happens, the receiver will drop packets (i.e. it will throw
packets away, because they are 'late to the party').

Packet loss results in audio glitches, so it is very important to ensure that all receivers have their latency set high
enough to prevent packet loss.

Setting device latency too high, however, can interfere with low-latency applications (for example, real-time
monitoring when recording vocals), so it is sometimes important to find a balance between low latency and
guaranteed audio integrity.

The Latency tab can be used to identify:

n Devices that are dropping packets because their latency is set too low

n Devices that are at risk of dropping packets because their latency is set too low

n Devices that could potentially have their latency reduced (if required; generally, the default Dante latency of
1ms is more than adequate for low-latency applications)

About the Histogram
The transmitter's name is displayed at the top of the histogram, along with the latency value against which the
histogram is reporting.

The horizontal axis shows the distribution of audio packet latency measurements from the transmitter. The vertical
axis shows the number of measurements recorded at each data point, on a logarithmic scale.

Measurements are taken at roughly 1 second intervals, from when Dante Controller is started.

To clear the histogram, click Clear. Latency measuring will then restart.

To save the histogram as a png image, click Save.

Note: If any subscriptions are via multicast flows, there may be two histograms displayed for one transmitter:
one histogram for the unicast flows, and one for multicast. This is because multicast flows always use a
latency of 1ms. If the receiver is set to a latency other than 1ms, two histograms will be displayed.

The following information is also displayed:
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n The latency Setting for the histogram. In most cases, this will be the same as the latency setting on the
receiver. However, for some subscriptions, Dante will automatically apply a different latency. For example:

o Multicast flows are automatically set to a minimum of 1ms
o If a transmitter does not support the latency set on the receiver (i.e. it can't guarantee delivery within the

required latency), Dante will increase the latency to the lowest setting supported by the transmitter.
Ultimo devices, for example, support a minimum latency of 2ms, so subscriptions to Ultimo devices will
use a minimum of 2ms latency.

n The Peak latency since measuring started

n The Average latency since measuring started

n The number of measurements taken that included one or more Late packets (note that each measurement
typically includes many packets)

Interpreting the Histogram
If all bars are green and falling well within the limit of the histogram (i.e. towards the left or middle of the histogram),
it indicates that the latency setting for the receiver is set high enough to prevent packet loss.

Show me

If any bars are amber, it means that some packets are arriving near the limit of the latency setting. Network traffic
fluctuations could potentially lead to extra delay which could cause packets to arrive late. A histogram of this type
indicates that the receiver latency should be increased if possible.

Show me
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If any bars are red, it indicates late packets, and audio loss. The receiver latency should be increased, or the
network reconfigured.

Note: Dante Controller can be left running for a few days to collect latency data, providing a long-term picture
of the latency performance of your network configuration. This is especially useful after any network
infrastructure upgrades, or after the addition of more end point load in a given network, to determine if QoS
tuning or increased capacity may be required at the network switch level.

Show me

Device Config Tab

This tab on the device view window allows you to configure device specific parameters. The specific options
available will depend on the capabilities of the device. In the case where a device does not support configuration via
Dante Controller, the tab will be disabled.
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Configurable Parameters

Rename Device

Allows you to enter a new Dante 'friendly name' for the device. The text field displays the current name.

To change the device name, enter a new name in the text field and press Enter.

See Device and Channel Names for information about name conflicts and device name rules.

Sample Rate

n Shows the current sample rate of the device, and allows you to change the operating sample rate of the
Dante device. This may require the device to be rebooted to take effect. All sample rates supported by the
device are shown in the drop down menu.

n Shows the current pull-up/down setting for the device, and allows you to change the pull-up/down setting.
The pull-up/down setting can be used to adjust the sample rate of the device to synchronise audio with video
that has undergone frame rate conversion. For example, to synchronise Dante audio with video that has been
converted from 24 fps to 25 fps, set the sample rate pull-up/down for any relevant Dante audio devices to
+4.1667%.

n Applies to audio channels only.
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Note: Changing the sample rate pull-up/down for a device places that device in a dedicated clock domain.
Dante devices can only transmit audio to, or receive audio from other devices on the same clock domain. See
Clock Status View for more information.

Preferred Encoding

Shows the current preferred encoding setting and allows you to change the preferred encoding setting for the
device.

Applies to audio channels only.

Note: This setting does not guarantee that the device will use always the selected encoding: Both devices
must support the selected encoding for it to be used.

Unicast Delay Requests

Delay requests are messages sent by clock followers to the clock leader to establish the time it takes for data to
traverse the network between the devices. By default, delay requests are multicast messages, and in networks with
lots of devices, they can add up. Enabling 'Unicast Delay Requests' forces clock follower devices to send delay
requests to the clock leader using unicast instead, which reduces multicast traffic.

Note: Unicast Delay Requests does not have to be enabled on the clock leader, only on the clock followers.

Important: Some older Dante devices do not support Unicast Delay Requests. Before enabling the feature for
your clock followers, check that your current clock leader supports the feature, by attempting to enable it for
the device. If the clock leader device does not support unicast delay requests, do not enable it on your clock
followers (it may prevent your devices from synchronizing). You can however choose an alternative clock
leader that does support it, and then enable it for the clock followers that also support it.

Device Latency

Shows the current device latency setting, and allows you to change the operating receive latency for the selected
device. Select a value and click OK to apply the latency to all flows that the device is receiving.

Applies to audio channels only.

Note: The 150 µsec setting is unavailable for devices that include an internal network switch.

Note: Device latency cannot be configured for Dante Via devices.

Note: Devices enrolled in a Dante domain may support extra latency values.

Warning: Changing the latency value will cause disruption in the audio while the flows are re-established at
the new latency setting.
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Reset Device

Allows you to remotely reboot the Dante interface, and also to reapply factory settings (Factory Reset). Rebooting
the Dante device may also require a reset of the host audio equipment containing the device.

Factory Reset wipes the following device configuration settings:

n User-defined device name

n User-defined channel names

n Clock configuration (clock leader / external clock leader setting)

n Static IP addresses

n Redundancy configuration

n Sample rate setting (including pull-up/down)

n Latency setting

n Any existing audio routes

Supported devices allow you to 'Clear Config' instead of Factory Reset. Clear Config wipes the same configuration
settings listed above, but allows you to optionally keep the IP settings (i.e. retain the Dante Redundancy settings,
and any static IP addresses currently configured in the Network Config tab).

A reboot is required after clearing the configuration for the changes to take effect. Some devices will allow you to
automatically reboot after clearing the configuration. If this option is not available, a manual reboot is required.

Clock Config Tab

Use the Clock Config tab to set the PTPv2 clocking configuration for devices that support RTP (AES67 and ST
2110-30).

See also: AES67 and SMPTE ST 2110-30 Audio

AES67 and ST 2110-30 require PTPv2 (Precision Time Protocol, version 2) for accurate clock synchronization.
Enabling PTPv2 for your devices allows them to send and receive RTP flows.
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To enable PTPv2 for your devices:

1. Open the Device View for the device.

2. Select the Clock Config tab.

3. For supported devices with AES67 enabled, the clock mode can be set to ‘AES67 Auto’ or ‘AES67 Manual’.
Auto mode can be used in most circumstances, and some settings are automatically set (and cannot be
changed).
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Note: ST 2110-30 and AES67 with manual clock mode allow explicit PTP priority configuration,
whereas AES67 Auto mode allows backwards compatibility with older devices, and defers to the device
to decide its own clock hierarchy priority (with Preferred Leader made available if required).

4. PTPv1 Multicast

l PTPv1 Multicast is disabled by default for ST 2110-30 and AES67 with Manual clock mode. Note
that this may disrupt clocking if there are PTPv1-only devices on the network and no devices using
both PTPv1 and PTPv2 to bridge the protocols.

5. PTP Follower Only

l Enable 'PTP Follower Only' if you want to ensure that this device never becomes the PTP Grand
Leader. This is useful if you have a dedicated clock device or want to avoid certain devices taking
over as the network clock source.

l Disable 'PTP Follower Only' if you want the device to be eligible to become the Grand Leader,
according to the PTP election process.

6. PTPv2 DSCP (Differentiated Services Code Point)

l The DSCP is a field in the IP packet header used to classify and prioritise network traffic (Quality of
Service, or QoS). Setting a specific DSCP value for PTPv2 traffic allows network switches and
routers to recognise and prioritise these packets, ensuring accurate and reliable clocking across
your network.

l Assigning a high-priority DSCP value to PTPv2 (such as EF or CS7) ensures these packets are
delivered reliably, even on busy networks.

l EF is the default value for PTPv2 event packets on all Dante devices. This value is specified by the
AES67 standard.

l PTP packets with a DSCP value of CS7 have higher priority those set to EF. This value is recom-
mended for Dante flows.

7. PTPv2 Domain Number (and subsequent settings)

l The PTPv2 Domain Number identifies the “domain” or logical group of devices that should syn-
chronize their clocks together. Devices with the same PTPv2 Domain Number will participate in the
same clocking group and synchronise with each other. Devices with different domain numbers will
ignore each other’s PTP messages and form separate clock groups. For most users, the default set-
tings will work. Advanced users can adjust priorities, sync intervals, and other options. For AES67,
the domain number is fixed at 0.

l Changing PTP Priorities and message intervals can break network clocks, causing loss of audio. It
is therefore recommended that only users with a good understanding of PTP parameters should
change priorities and message intervals.

l Note: In managed (DDM or Director) networks, the PTPv2 clock domain configured for the domain
or site must match that of the flow. If they do not match, when you attempt to subscribe to the flow,
Dante Controller will report 'Clock domain mismatch'.

8. Apply Settings

l Click Apply to save changes.

In ST 2110-30 mode, you can copy your clocking settings to another device:

1. Select the required parameters and click Copy.

2. A list of compatible devices is displayed.

3. Select the devices you want to copy the settings to and click Ok.
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Plugins

Some devices may present additional 'plugin' tabs, defined by the device manufacturer, for configuration and
display of additional device settings, such as video format and/or ancillary channel settings.

The contents of these tabs will vary based on the controls and information that the device manufacturer has chosen
to expose.

Refer to the user guide for your particular device for more information.

An example Video Config plugin tab is shown below.

Network Config Tab

Use the Network Config Tab to toggle supported devices between Redundant and Switched modes, and to specify
static IP addresses for a device's Ethernet ports.
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Dante Redundancy / Switch Configuration
Depending on the manufacturer's configuration of a device, it may be possible to toggle the device between
Redundant and Switched modes, or to select a Switch Configuration.

Redundant

When a device is set to Redundant, the device will duplicate Dante media traffic to both Ethernet ports, allowing the
implementation of a redundant network via the secondary port. Not all devices support redundancy.

Switched

When a device is set to Switched, the secondary Ethernet port will behave as a standard switch port, allowing daisy-
chaining through the device.

Switch Configuration

Certain devices support specialist switching and/or redundancy configurations for the Ethernet ports. For these
devices, the top pane of the Network Config tab will be titled 'Switch Configuration'. Please refer to the
manufacturer's technical documentation for information on the supported switching configurations for the device.
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Addresses
Dante devices obtain IP addresses automatically by default, and in the vast majority of circumstances there is no
need to change the Addresses settings. However, static IP addresses can be assigned if necessary.

To assign a static IP address:

1. Select 'manually configure an IP Address' for the appropriate Ethernet port.

2. Enter the IP Address and Netmask.

3. Click Apply.

The DNS Server and Gateway settings are optional - the device will use network defaults if they are not specified.

Click Revert to revert back to the previous settings.

Note: Assigning static IP addresses requires a device reboot.

RTPConfig Tab

Use the RTP Config tab to set the RTP mode (AES67 / ST 2110-30) for supporting devices.

See also: AES67 and SMPTE ST 2110-30 Audio

Check Device Compatibility
Not all Dante devices support AES67 or ST 2110-30. In Dante Controller, compatible devices will show an “RTP
Config” tab in their device view.

To set the RTP mode:

1. Open the Device View for the device you want to configure.

2. Select the RTP Config tab.

3. Choose the RTP mode:

l AES67: For interoperability with other AES67 devices.
o Supports up to 8 audio channels at 48 kHz or 96 kHz sample rates

l ST 2110-30: For broadcast environments requiring compliance. Six profiles are supported:
o ST 2110-30 A: Up to 8 audio channels at 48 kHz with 1ms packet times

o ST 2110-30 AX: Up to 8 audio channels at 96 kHz with 1ms packet times

o ST 2110-30 B: Up to 8 audio channels at 48 kHz with 125 µs packet times

o ST 2110-30 BX: Up to 8 audio channels at 96 kHz with 125 µs packet times

o ST 2110-30 C: Up to 64 audio channels at 48 kHz with 125 µs packet times

o ST 2110-30 CX: Up to 64 audio channels at 96 kHz with 125 µs packet times

Note: Not all options are supported by all Dante devices - only supported options will be available based on
the device capabilities.
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AES67Mode

Devices in AES67 mode are able to transmit and receive AES67 multicast flows to / from non-Dante AES67-
enabled devices. Between Dante devices, Dante's native audio transport protocol is used instead (even when
AES67 is enabled for both devices).

In AES67 mode, the following settings are available:

RTPMulticast Address Prefix

You can use the RTP Multicast Address Prefix field to specify a multicast subnet, for cases where you need to
transmit to or receive from a particular address range.
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The multicast address prefix set at device level does not affect which AES67 flows from non-Dante devices are
displayed in Dante Controller. However, when subscribing a Dante device to a non-Dante Tx flow, the multicast
address prefix set for the receiver must match that of the Tx flow. If they do not match, the subscription will appear to
succeed, but audio will not actually flow.

Dante devices are able to transmit RTP flows on any IP address. However, some devices will only subscribe to
AES67 flows in the 239.x/16 address range:

n Brooklyn II

n Dante HC

n Broadway

n Older Brooklyn 3 (up to and including v4.2.x firmware)

n Older Zynq IP Core (up to and including v4.2.x firmware)

If you need to subscribe any of these Dante device types to an RTP audio flow from a third-party device, ensure that
the transmit flow is in the 239.x/16 address range.

RTP Flow Format

Defines the encoding (audio bitrate) for AES67 flows to or from this device.

RTP Latency

Defines the receive latency for RTP audio flows on the device.

External AES67 Sessions

Click this button to add an external session (see below).
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ST 2110-30Mode

Devices in ST 2110-30 mode are able to transmit and receive ST 2110-30 multicast flows to / from non-Dante ST
2110-30-enabled devices. Between Dante devices, Dante's native audio transport protocol is used instead (even
when ST 2110-30 is enabled for both devices).

In ST 2110-30 mode, the following settings are available:

RTP Payload Type

Payload ID specifies the properties of an RTP audio flow. Dante transmitters allow dynamic Payload ID ranges (as
specified in RFC3551). Users can set a value from 96 to 127 on the Dante transmitter.
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RTPMulticast Address Range

The multicast address range determines which IP addresses are used for audio flows. For ST 2110-30, addresses
are assigned by default but can be customised. Always ensure the address range is compatible with all devices
involved.

RTP Flow Format

Defines the encoding (audio bitrate) for RTP audio flows to or from this device.

RTP Latency

Defines the receive latency for RTP audio flows on the device.

External ST 2110-30 Sessions

Click this button to add an external session (see below).

Controls Tab

For supported devices, the Device View also includes a Controls tab. Use the Controls Tab to adjust audio controls
for the selected device.

The displayed control set varies between devices.
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HA Remote Tab

For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View also includes an HA Remote tab.
The HA Remote tab allows the selection of the HA Remote bridging mode for the device.

HA Remote is a proprietary serial control protocol used by Yamaha products. For more information about
HA Remote bridging modes, please download the latest version of the Dante-MY16-AUD user guide from the
Yamaha website.

Avid Config Tab

For supported devices (DNT-192 expansion cards), the Device View also includes an Avid Config tab.

The Avid Config tab allows the configuration of the DNT-192 card, and displays relevant firmware and hardware
version information.
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The tab includes 3 sections:

n Avid Dante Card Information: Displays information about card hardware and software versions

n Avid Rack Status Information: Displays information about the rack status for the card

n Avid Dante Card Control: Allows the configuration of various DNT-192 settings

Avid Dante Card Information
This section displays:

Application version

The version of the Dante application currently installed on the DNT-192 card.

FPGA Version

The version of the FPGA binary on the card.

Board Version

The hardware version of the card.
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Avid Rack Status Information
This section displays:

Rack Sample Rate

The sample rate at which the rack is currently set to.

RackMute Status

The mute status of the rack.

Avid Dante card Control
This section allows high-level configuration of the DNT-192 card.

Card Configuration

In ‘Dante’ mode the card configuration is automatically set by the rack. In ‘Generic’ mode the configuration is
manually selectable.

The Card Configuration option supports 3 values:

n Input card: The card functions as a 16-channel input device

n Output card: The card functions as a 16-channel output device

n Input/Output card: The card functions as an 8-in + 8-out device

SRC

Sample Rate Conversion.

When enabled, the card will convert incoming (Rx) audio to the Rack Sample Rate (if required), and outgoing (Tx)
audio to the sample rate of the receiving device on the Dante network (if required).

Note that SRC adds latency of roughly 1.3ms to the Dante subscription in each direction.

Card Identity

n Dante: The card will identify itself as a Dante device to the host device rack, enabling Dante functionality on
the host device. Required for Dante-enabled host equipment.

n Generic: The card will identify itself as a generic digital audio interface (required for non-Dante host equip-
ment).

Flow Information

The Flow Information dialog displays any audio, video or ancillary flows to and from the device .

To open the Flow Information dialog, open the Device View for the device and select View > View Flow Information.

In the example below, the device supports 32 audio transmit flows and 32 audio receive flows.
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MulticastTransmitFlowConfiguration
Click the 'Create a new multicast flow' button in Device View to open the Create Multicast Flow dialog.
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The dialog displays a list of the Tx channels for the device.

To add channels to a multicast flow, select the checkboxes for the channel name. Once you have selected all the
channels required, create the multicast flow by clicking the Create button at the bottom of the dialog box. To
abandon creating a new multicast flow, click Cancel.

Once a flow has been created, it will appear in the list of flows in the transmit pane, along with the channels
contained within that flow. Channels cannot be added to or removed from existing flows. Each time the dialog is
used to select additional channels, a new multicast flow will be created.

By default, Dante receivers will connect to a multicast flow if one exists that contains the required channel(s), rather
than creating a new unicast flow.

If a channel that does not form part of an existing multicast flow is added to a new multicast flow, any existing
unicast subscriptions to that channel will automatically switch over to use the new multicast flow.

A good rule of thumb is to use multicast when there are more than two receivers for a specific media channel. You
should also assume that the flow will flood throughout the entire network, and therefore consume bandwidth on all
network links.

Note: Some ancillary channel types for video (Dante AV) devices cannot be added to multicast flows.
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MaximumChannels per Flow (Audio Devices Only)

The number of channels that can be added to a Dante multicast flow varies by device type. This is displayed at the
top of this window, and is 64 channels for the device shown above.

If you select more channels than the maximum supported channels per flow, multiple flows will be created. For
supporting devices, you can restrict flows to fewer channels if required, using the drop-down menu in the
Flow Config section.

This control also affects the number of audio samples per packet:

Maximum Channels Setting Samples per Packet

16 16

32 8

64 4

Smaller packet sizes may enable lower device latency settings for relevant subscriptions – use the Latency tab in
Device View to monitor latency performance.

Note: Dante devices on legacy (pre v4.2 firmware) will reject a 'create multicast flow' operation with more
than 8 channels.

Note: Video flows support only 1 video channel.

Managing Flow Size
Multicast flows propagate through the network to every device that requests one or more of the channels in the flow.
When considering network traffic management, in a typical network where no devices actually need all channels, it
would be more advisable to create multiple flows than it would to create one flow containing all channels.

In the first example illustrated below, one multicast flow was created, containing four channels. None of the devices
actually require all four channels, but both switches are processing four channels of traffic.

In the second example, two flows were created with two channels each. All devices are receiving the channels they
need, but the switches are processing half the traffic.
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Figure 1 - Single multicast flow with all channels

Figure 2 - Two multicast flows, with half the number of channels in each

DeletingMulticast Flows

Care should be taken when deleting a multicast flow, as the existing subscriptions will convert back to unicast. This
has the potential to result in exceeding the link capacity or maximum number of flows at the transmit device, as
multiple unicast flows will be established between the transmitter and its receivers. It may be advisable to remove
some or all of the media routes prior to deleting the multicast flow.
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Note: Certain Ethernet switches support IGMP (Internet Group Management Protocol), a protocol that
provides the ability to 'prune' multicast traffic, so that it travels only to those end destinations that require that
traffic. If this is the case, and IGMP is correctly configured on all the Ethernet switches, then multicast media
will not flood throughout the network, but will instead be sent only over the links required to deliver it to
subscribed devices.

AES67 and SMPTE ST 2110-30 (RTP) Flows

See:

AES67 and SMPTE ST 2110-30 Audio

RTP Config Tab

Clock Config Tab

Creating AES67 or ST 2110-30 (RTP) Transmit Flows

Adding External SDP Sessions

AES67 and SMPTE ST 2110-30 Audio

Dante Controller supports the reception and transmission of audio flows using the AES67 and SMPTE ST 2110-30
RTP (Real-time Transport Protocol) standards, in managed (DDM / Dante Director) networks and unmanaged
networks. These features allow Dante devices to interoperate with a wide range of third-party audio-over-IP
equipment in broadcast and professional audio environments.

What are AES67 and SMPTE ST 2110-30?
n AES67 is an open standard for audio-over-IP interoperability, allowing devices from different manufacturers

to exchange audio streams.

n SMPTE ST 2110-30 is a broadcast industry standard for transporting audio over IP networks, building on
AES67 with additional requirements for clocking and network configuration. Refer to the SMPTE Standard
(SMPTE ST 2110 -30:2017) for more information about SMPTE audio.

Dante devices with these RTP features enabled can send and receive audio flows to and from compatible non-
Dante devices.

RTP support needs to be configured in two places:

The RTP Config tab
Where you set the RTP mode for the device.

RTP Config Tab

The Clock Config tab
Where you set the specific clock settings for the selected RTP mode.

Clock Config Tab
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Creating and Subscribing to RTP Flows
With RTP properly configured, you can create RTP transmit flows and subscribe to RTP flows from non-Dante
devices.

Creating AES67 or ST 2110-30 (RTP) Transmit Flows

Adding External SDP Sessions

Note: Dante Controller Presets support AES67 and ST 2110-30 configuration.

Monitoring and Troubleshooting

Status Indicators

Devices and flows will show status icons for AES67 or ST 2110-30 compatibility.

Warnings will appear if there are clocking mismatches, unsupported settings, or network issues.

Legacy Devices

Older Dante devices may not support all features. Advanced options will be greyed out or unavailable.

Mixed Networks

Avoid mixing AES67 and ST 2110-30 modes on the same network unless you understand the implications for
clocking and compatibility.

Creating AES67 or ST 2110-30 (RTP) Transmit Flows

Note: Ensure you have configured the RTP Config and Clock Config for RTP support.

1. In Device View, either:
o Click the 'Create a new multicast flow' button:

o Or, select the Transmit tab, and in the Multicast Transmit Flows panel, click Add.

2. Select AES67 or ST 2110-30 (A, B or C when configured for 48kHz, AX, BX or CX for 96kHz) as the flow type
(available options will depend on the RTP config for the device).
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AES67 Flows

Setting Up AES67 Flows

1. Set the IP Address for the flow, and the Port number.

Note: Dante devices are able to transmit RTP flows on any IP address. However, some devices will only
subscribe to AES67 flows in the 239.x/16 address range:

l Brooklyn II

l Dante HC

l Broadway

l Older Brooklyn 3 (up to and including v4.2.x firmware)

l Older Zynq IP Core (up to and including v4.2.x firmware)

If you need to subscribe any of these Dante device types to an AES67 flow from a third-party
device, ensure that the transmit flow is in the 239.x/16 address range.

2. Select the channels you want to add to the transmit flow. If the number of selected channels exceeds the
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maximum number supported by the config, multiple flows will be created.

3. Click Create.

Only AES67-enabled devices can receive AES67 flows. Dante devices cannot subscribe to AES67 flows from other
Dante devices.

For AES67-enabled Dante devices, each device transmit channel can simultaneously support an AES67 multicast
flow and a standard Dante multicast flow. PTPv1 Multicast must be enabled in the PTP Clocking Parameters to
support this.

Subscribing to AES67 Flows

RTP transmit flows (including AES67 flows) from non-Dante devices appear in blue at the far right of the Routing tab
of the Network View, and at the bottom of the Available Channels list in the Device View > Receive tab. AES67 flows
are identified by their transmit multicast IP addresses, rather than device names.

AES67 channels can be subscribed to (by supporting devices) in the same way as channels from other transmitters.

ST 2110-30 Flows

Setting Up ST 2110-30 Flows
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1. Set the profile (A, B or C when configured for 48kHz, AX, BX or CX for 96kHz).

2. Set the IP address and port number. For ST 2110-30 flows, the IP address must be in the range 239.0.0.0 to
239.254.254.254. The port can be set to any non-administrative port number.

3. Select the channels you want to add to the transmit flow. If the number of selected channels exceeds the
maximum number supported by the config, multiple flows will be created.

4. Click Create.

ST 2110-30 flows created in Dante Controller are advertised on the network via SAP/SDP.

The transmit flow will present in the controller software for your ST 2110-30 receiver if it natively supports SAP/SDP
parsing. If not, an alternative mechanism will be required to parse the SDP descriptor for the flow. The configuration
of third-party ST 2110-30 receivers is specific to the receiver.

For ST 2110-30-enabled Dante devices, each device transmit channel can simultaneously support an ST 2110-30
multicast flow and a standard Dante multicast flow. PTPv1 Multicast must be enabled in the PTP Clocking
Parameters to support this.

Subscribing to ST 2110-30 Flows

ST 2110-30 transmit flows from non-Dante devices appear in blue at the far right of the Routing tab of the Network
View, and at the bottom of the Available Channels list in the Device View > Receive tab.

The device name is taken from the SDP descriptor for the flow as advertised by the device, or configured in Dante
Domain Manager. If the transmitter does not advertise flows via SAP/SDP, you can use Dante Controller (or DDM)
to generate a 'proxy' RTP session with a descriptor that is supported by Dante Controller.
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ST 2110-30 channels can be subscribed to (by supporting devices) in the same way as channels from other
transmitters.

Adding External SDP Sessions

To receive audio from a third-party device, you may need to add (import) an SDP descriptor to Dante Controller.

1. Obtain the SDP Descriptor.

l Typically, the SDP descriptor is retrievable via the device’s user interface (for example, a web
interface).

2. Add the Descriptor to Dante Controller, using the ‘Manage External AES67 / ST 2110-30 SDP Sessions’
dialog (shown above).

You can open the dialog in two ways:

l Go to the File menu > External SDP Sessions and click Add.

Open the Device View for your Dante device, go to the RTP Config tab and click Add Session.

3. Paste the SDP descriptor into the session management dialog and click Add. The session will appear in the
list at the top of the dialog, and in the Transmitters list in the Routing View.
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Removing SDP Sessions
To remove an SDP session, select the session in the Manage External Sessions dialog and click Remove. You can
also use Remove All to remove all active sessions.

Exporting SDP Sessions
You can export multiple active sessions as an SDP (.sdpa) file for archiving. Note that .sdpa files are not human-
readable, but can be imported back into Dante Controller via the Manage External Sessions dialog to restore the
sessions.

Viewing SDP Descriptors
In the Transmit tab, an information icon Info is shown alongside RTP flows. Click the icon to see the SDP
information for the flow.
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MediaEncryption

Overview

Dante media encryption extends the security benefits of using Dante on your network by concealing the media
content during transmission between devices. Dante utilises the Advanced Encryption Standard (AES) with a 256-
bit key to provide industry-leading media protection. Concealing the contents of media packets prevents malicious
or unauthorised users eavesdropping or interfering with Dante media traffic.

Media encryption does not affect flow latency, and no action is required by users to manage encryption keys. Keys
are automatically rotated regularly for additional security.

Media encryption is automatically enabled by Dante Director when supporting devices are enrolled into a Site.

Encryption Policies

Transmit channel encryption policies can be set on a per-device or per-channel basis in Dante Director. Dante
provides two policies which can be applied to transmit channels: Strict and Compatible.

n Strict policy requires the channel to be transmitted within an encrypted flow and is the recommended setting
for the highest level of security.

New subscriptions to a Strict channel will successfully be created only if the receiving device also supports
Dante media encryption. If the receiver is not capable of encryption, the subscription will fail, and Dante
Controller will present an error message to the user.

n Compatible policy enables an interoperable behaviour that supports unencrypted flows when transmitting to
legacy devices.

When a transmit channel is configured with a Compatible policy, Dante will first attempt to create a
subscription as an encrypted flow. This ensures networks naturally become more secure as new device
firmware is made available. However, if the receiving device is incapable of encryption, the subscription will
resolve as an unencrypted flow.

Transmit channel encryption policy can only be configured through Dante Director.
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Device media encryption configuration persists across device reboots, and does not require management
applications such as Dante Director or Dante Domain Manager to be online (subsequent to initial configuration).

Encryption Icons

Devices that support media encryption (with any mix of Strict or Compatible policy channels) are identified in the
Network Status View of Dante Controller using this icon:

Transmit channels set to Strict policy (they require encryption support from the receiving device) are identified in the
Network Status View and Device View > Transmit tab using this icon:

Receive channels that are currently subscribed to an encrypted flow are identified in the Network Status View using
this icon:

Subscriptions to an encrypted flow are identified in the Network Status View and Device View > Receive tab using
this icon:

You can hover over a subscription icon in the Network Status view to see more information about the subscription.

Encryption status icons also appear in some other tabs. Exact colours vary between light and dark mode interface
settings.

An example of how the icons might appear in the Network Status View is shown below.
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Receive and Transmit Tabs

In Device View for supported devices, the Receive and Transmit tabs also show signal status icons for encrypted
subscriptions (shown in the table below), indicating the signal status at each end of the subscription.

Subscription

Summary

Signal Icons Audio Availability Receiver Transmitter

Available Active Active

Not available
(audio presence
cannot be ascertained)

Active Active

Silence
(no active audio on
the subscription)

Active Active

Muted Active Active

Pending / none Pending / none
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Subscription

Summary

Signal Icons Audio Availability Receiver Transmitter

Active Pending / none

Error Error

Active Error

Error Pending / none

Pending / none Error

For the signal icons:

n Green indicates a good signal

n Orange indicates a pending signal

n Red indicates an error

You can hover over the icon for subscriptions with errors to see more information about the subscription issue - for
example:

n The session key ID does not match the media flow key ID

n The flow ID in packet is incorrect in the current flow context

n The sentinel check failed

n The data encrypt/decrypt subsystem has returned an error

n Invalid packet data

If you encounter any persistent encrypted subscription errors, please contact Audinate technical support for more
information.

An example Device View > Receive tab is shown below:
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Multicast Transmit Flow Encryption

Encryption is supported for multicast flows. If a multicast flow includes any Strict policy encrypted channels, the
entire flow will be encrypted. This means that receivers must support encryption in order to subscribe to a multicast
flow containing any Strict policy encrypted channels.

Multicast flows containing only Compatible policy channels will not be encrypted.

Strict policy encrypted channels cannot be added to AES67 or SMPTE ST 2110-30 multicast transmit flows.
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UsingDanteControllerwithDanteDomain
Manager

AboutDanteDomainManager
Dante Domain Manager (DDM) is a complete management solution for Dante systems.

With DDM, integrators can define specific AV device groupings, by room, building and site, allowing for the creation
of independent Dante Domains, and enabling a single Dante Domain to encompass multiple network subnets.

DDM provides robust security for IT departments and AV managers, including user authentication and encrypted
control, role administration and integration with Active Directory. System managers gain complete visibility and
accountability with a suite of dashboards, audit trails, alerts and SNMP support.

DDM is a virtualized application that runs on desktop and server platforms, with an intuitive and highly responsive
web interface for desktop, tablet and mobile browsers.

For more information about DDM, refer to the DDM user guide.

ViewingDomains inDanteController
To view enrolled devices in Dante Controller, the user must connect to the DDM server using their configured DDM
credentials, and then select the appropriate domain for viewing.

Connecting to a DDM Server

To connect to a DDM server:

1. In the Dante Controller toolbar, click the DDM / Dante Director Login button: 

The DDM / Dante Director Login dialog is displayed.
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2. In the DDM / Dante Director Login dialog, either:
n Select 'Auto-Detect Server' to search for a DDM server automatically*, or:

n Enter the relevant server name** (FQDN) or IP address, and the port number.

3. Enter your user name and password.

4. Click Log in.

* Auto Discovery requires DNS if Dante Controller and the DDM server are in different IP subnets.

** Requires DNS.

First-time Connections
The first time an installation of Dante Controller connects to a DDM server, a pop-up dialog is displayed:

Click Yes to connect to the DDM server, or No to cancel the connection.
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This security mechanism enables you to verify that the DDM server at the specified server name / IP address is the
server to which you actually intended to connect.

If the underlying DDM server at a previously used server name / IP address changes, you will see a warning pop-up,
so you can cancel the connection if required.

The fingerprint is a unique ID for the DDM server, and is saved locally to your computer.

You can view known fingerprints in the ddm_hosts file at:

n Windows:  C:\Users\<user name>\AppData\Local\Dante Controller

n macOS:  ~/Library/Application Support/Dante Controller

You can also view the fingerprint for a DDM server instance in the Network & Security settings of the DDM user
interface.

Viewing a Domain

To select a domain for viewing, select the required domain from the Domain drop-down menu in the Dante
Controller main toolbar.

The domains and devices you are able to view and configure are determined by your DDM user account privileges.

The currently logged in user and their relevant domain privileges are displayed next to the Domain drop-down
menu.

Note: When connected to the <unmanaged> domain, Dante Controller will only display devices in the local
subnet.

ConnectingDevices toaDomainManager
For networks in which devices are unable to automatically discover DDM in your Dante network - for example, multi-
subnet systems without a DNS server - you can 'connect' your devices to DDM so that they appear in the DDM web
interface, and can be more easily enrolled into domains.

This function forwards the DDM server address to your devices, so they can advertise their presence on the network
to DDM.

It is a convenient alternative to enrolling devices by IP address.

To connect your devices to DDM:

1. Log in to DDM and ensure the 'Unmanaged' domain is selected.

2. In Dante Controller, from the Devices menu, select 'Connect Devices to DDM / Dante Director'.

The 'Connect Devices to DDM / Dante Director' dialog is displayed:
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3. The devices in your network that are currently visible to Dante Controller are displayed.

4. Leave 'Assign to Domain' as 'Assign Later' (this feature is currently only supported by Dante Director).

5. Select the required devices and click Ok. You can use the 'All' or 'None' buttons to select or deselect all
devices in the list.

* Requires DNS.

Note: Dante Controller can typically only discover un-enrolled devices in its local IP subnet. To connect
devices in another subnet to DDM, first connect Dante Controller to the relevant subnet, and then repeat the
process above.

Note: You can also use this function to inform your devices about a known DDM server address before DDM
becomes online in your network.

VirtualDevices
DDM supports the sharing of audio between domains using the concept of 'virtual' devices.

A virtual device is a 'projection' of a real device, which can appear in multiple domains simultaneously, and can be
subscribed to by real devices in those domains. It presents in Dante Controller as an independent transmitter, but is
really just a logical entity which acts as a subscription proxy for a real device.
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Virtual devices are instantiated when real devices are shared between domains using DDM. They cannot be
created using Dante Controller.

Using DDM, you can control the domains in which a virtual device appears, and which channels on the real device
are exposed by the virtual device. Virtual devices can be assigned their own individual device names.

In Dante Controller, virtual devices are represented using green device names. The number of transmit channels
they present is dependent on the number of channels that have been shared on the real device (using DDM).

When you subscribe to a virtual device, the audio you receive is from the real device. Virtual devices cannot
subscribe to other devices.

Note: The usual configuration options are disabled for virtual devices.

LegacyDevices
Devices with some legacy (pre-v4.0) versions of firmware can be 'associated' with domains using DDM. This adds
them to the relevant clock domain, and allows them to exchange audio with devices enrolled in the same domain,
which are also on the same IP subnet (legacy devices do not support audio routing between subnets).

When legacy devices are associated with a domain, they only appear in Dante Controller when you are logged into
the relevant domain (unless they have been specifically revealed - see Hidden Legacy Devices below).

Note: Dante Controller must be connected to the same subnet as a legacy device in order for it to appear in
the Dante Controller interface.

Important: When legacy devices are associated with a domain, they are not protected from unauthorized
access via Dante Controller. Also, when associated, they are placed in a dedicated clock domain and thus can
no longer exchange audio with unmanaged devices.
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Hidden Legacy Devices

If a legacy device is moved to an unmanaged Dante network without first being de-associated, it will not appear by
default in Dante Controller.

Dante Controller notifies you with a spy icon (next to the network status icons at the bottom left of the UI) if you have
hidden devices on your network:

To view hidden devices in Dante Controller, select View > 'Show Hidden Devices'.

For more information about legacy devices, see the DDM user guide.

DomainCredentials
When a device is enrolled in a Dante domain, information about the relevant DDM server and the domain in which it
is enrolled is saved to the device. When the device is unenrolled, the domain membership information is cleared,
and the device returns to the unmanaged (unenrolled) domain.

If an enrolled device is moved out of the DDM network to another network without first being unenrolled, it will not
appear in Dante Controller, because its domain credentials indicate that it is still enrolled in a domain. In these
circumstances it is necessary to clear its domain credentials so that it appears as an unmanaged device in Dante
Controller and can be used again.

To clear the domain credentials for a device, it must first be isolated using the same method for resetting a device
lock PIN.

1. Isolate the device.

2. Open the Device View for the device.

3. From the Device menu, select Clear Domain Credentials.
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Presets
Dante Controller supports the saving and loading of Dante network routing and device configurations, known as
'presets'. A preset file contains configuration and routing parameters for some or all of the devices in the network.

Preset files are saved as xml, and can be edited offline. They are also 'device-agnostic' - they can be shared
between networks with different physical devices.

You can use presets to:

n Backup and restore network configurations

n Quickly switch between saved network configurations

n Copy a Dante network configuration from a 'lab' or test network to a live or production network

n Create network configurations for special, or periodic events, and then switch back to the standard
configuration when desired

n Quickly apply one or more configuration settings to a number of devices simultaneously - for example, setting
all devices on your network to the same sample rate (global configuration)

n Manually edit saved preset configuration XML files for reuse in new network configuration deployments

AboutDeviceRoles
Presets introduce the concept of 'device roles'. When a preset is saved, the configuration and routing for each
selected device is saved into the preset as a device role, with the same name as the device from which it was
created.

The role is not 'tied' to its originating device. When a preset is loaded into Dante Controller, each role can be applied
to its originating device, or to another device (even if it does not support exactly the same functionality). It is a
transferable set of device configuration and routing parameters.

For example:

Dave the sound engineer has gigs on Friday and Saturday night at a local venue. On Friday evening before
the gig, he sets up his Dante network at the venue, and when he's happy with it, he saves the preset.

After the gig, Dave's boss turns up and steals the mixing console for another job. Dave, however, has a
friend with a similar console (conveniently from the same manufacturer, and with a higher channel count)
which he can borrow for Saturday's gig.

The next night, Dave simply connects the new mixing console to the network, in place of the old one, and
reloads his preset. The new console is now configured exactly like the old one - including all of the relevant
channel names, and media subscriptions - and the network functions exactly as before, without any need
for further configuration. The gig goes really well, and the band takes Dave out for dinner.

If a role is applied to a device that is different from the role's originating device - for example, a role for console
model A is applied to console model B - Dante Controller will identify any issues that might arise (such as
unsupported sample rates) and will display those issues so they can be addressed - or ignored, if they are not
important.
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SavingPresets

To save a Preset that includes all device parameters:

1. Click the ‘Save Preset’ button in the main toolbar: 

2. Select the devices that you wish to include in the preset.

Click All to select all devices, or None to clear all selections.

3. Click Save.

To save a Preset that includes a selection of device parameters:

1. Click the ‘Save Preset’ button in the main toolbar.

2. Click Advanced.

3. Select the devices that you wish to include in the preset.

4. Select the parameters that you want to save for the selected devices.

5. Click Save.

Presets are saved as an xml files, which can be manually edited if required, using a text editor.

See Preset Elements - Configuration Parameters for more information about supported Preset parameters.
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Parameter Rules

Rx Subscriptions
If ‘Rx Subscriptions’ are included in the preset, and applied to the target system (i.e. ‘Rx Subscriptions’ is checked in
the Advanced > Parameters column when the preset is saved, and also checked in the Preset Elements column
when the preset is applied):

All subscriptions for all matched devices on the target system will be updated to match the source system. This
means that:

n All subscriptions saved into the preset will overwrite the respective subscriptions for matched devices on the
target system. If the subscriptions are identical, they are maintained.

n Any existing subscriptions on the target system that do not exist in the preset will be removed, regardless of
whether any subscriptions are defined in the preset.

Tx Flows (multicast flows)
The behaviour for TX Flows and Tx Channel Names is different to that of Rx Subscriptions.

If ‘Tx Flows’ are included in the preset, and applied to the target system (i.e. ‘Tx Flows’ is checked in the Advanced >
Parameters column when the preset is saved, and also checked in the Preset Elements column when the preset is
applied):

n All Tx flows saved into the preset will overwrite the respective Tx flows for matched devices on the target sys-
tem.

n Any Tx flows on the target system that do not exist in the preset will be removed, if at least one Tx flow is
defined in the preset. Otherwise (i.e. if no Tx flows are defined in the preset), all Tx flows on the target system
are maintained (note this is different to how Rx subscriptions are handled).

n Multicast flows and/or transmit channel names can be manually deleted from the target device prior to or fol-
lowing the preset application.

Tx Channel Names
The behaviour for Tx channel names is identical to the Tx flows behaviour described above.

ApplyingPresets
To load and apply a saved preset, select File > Load Preset from the main menu (Ctrl + L).

Legacy preset files are supported.

The 'Apply Preset' dialogue is arranged in 4 columns, representing the logical steps in applying a preset (from left to
right).
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Preset Elements

Use the Preset Elements column to select the parameters that you wish to apply from the preset to the target
network.
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If the target network is not identical to the original network (from which the preset was saved), some elements might
not be applied successfully. For example, if some devices on the target network do not support the same range of
sample rates as the devices on the original network, you could choose not to apply the 'Device Sample Rate'
element, and change the sample rates manually instead, once the preset has been applied.

See Preset Elements - Configuration Parameters for more information about supported Preset parameters.

Preset Roles

The Preset Roles column lists the roles that were saved in the preset.
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You can apply a role to the same physical device from which it was created (if it exists in the target network), or to a
different device in the same network, or to another device in a new network.

When a role is applied to the same physical device, or a device of the exact same model, the configuration and
routing should be replicated perfectly (although some subscriptions may be 'broken', if the relevant transmitters are
not also present on the target network).

Note: This makes presets an ideal way to backup and restore configurations for relatively static networks.

If a role is applied to a different device model or a different type of device, the configuration and routing may not be
replicated exactly - the success of the role assignment will vary depending on the functionality and channel support
of the target device.

Applying a role to a fundamentally different type of device may not be very successful. For example, applying a role
for a fully-subscribed 32-channel mixing console configured at 96kHz to a 2-channel amplifier that only supports
48kHz will be problematic - only two channels can be subscribed (assuming the transmitters are also present), and
the sample rate will be rejected.

You can apply a role to multiple devices. You cannot apply multiple roles to one device.

To see which devices a role has been assigned to, click the role. The assigned device/s will be highlighted in the
'Target Devices' column.

Automatic Assignments
Dante Controller will automatically assign roles to devices, based on the following rules:

n If there is a perfect device match (i.e. the physical device in the original network from which the role was cre-
ated is also found in the target network), the role is assigned automatically

n If there is a device name match, the role is assigned automatically

n If a perfect match or a device name match cannot be made, the role will be assigned automatically to a device
of the same manufacturer and model, assuming there is an unassigned device of that type

Removing Assignments

To remove an assignment, select the target device and click Clear or press the Delete key on your keyboard.

Manual Assignments
To manually apply a role to a device:

n Drag the role onto the device, or:

n Select the role in the 'Preset Roles' column and the target device/s in the 'Target Devices' column, and click
Apply.

The LED icons against each role indicate the assignment status of the role.
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 A light grey icon indicates that the role has not been assigned to any target devices.

 A green icon indicates that the role has been successfully assigned to one or more target devices.

 An amber icon indicates that the role has been assigned to one or more target devices, but there is a warning

condition associated with one or more of the assignments.

 A red icon indicates that the role has been assigned to one or more target devices, but there is an error

condition associated with one or more of the assignments.

 A dark grey icon indicates that the role has been assigned to a target device, but the assignment will have a

potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal issues are
identified.

Target Devices

The Target Devices column lists the device names of devices on the currently connected Dante network, and the
roles that have been assigned to them (if applicable).

The LED icons against each device indicate the assignment status of the device.

 A light grey icon indicates that the device has not been assigned a role.

 A green icon indicates that the device has been successfully assigned a role.

 An amber icon indicates that the device has been assigned a role, but there is a warning condition associated

with the assignment.

 A red icon indicates that the device has been assigned a role, but there is an error condition associated with of

the assignment.

 A dark grey icon indicates that the device has been assigned a role, but the assignment will have a potentially

terminal effect on the operation of the network. A preset cannot be applied if any terminal issues are identified.

Issues

The Issues column lists all issues identified by Dante Controller. Clicking a role or a target device will highlight the
issues associated with that role or role assignment.
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The following are 'terminal' issues that could render the network unusable (identified by a black LED icon):

n You cannot apply the same device name to multiple devices.

n You cannot apply the same static IP address to multiple devices.

Other issues may or may not be a problem, depending on your requirements for the network.

Applying the Preset

To apply the preset, click OK. Click Cancel to abandon the operation.

Global Configuration

You can use the Presets feature for global configuration, i.e. applying one or more configuration settings to a
number of devices simultaneously.

For example, if you want to apply the same sample rate to all devices on your network:

1. Set one of your devices to the required sample rate.

2. Click the Save Preset button

3. Click None, then select only the relevant device.

4. Click Advanced.

5. Click None, then select the 'Device Sample Rate' checkbox.

6. Click Save.

7. Load the preset (File > Load Preset).

8. In the 'Preset Roles' column, select the relevant role.

9. In the 'Target Devices' column, click Select All.

10. Click Apply then click OK.

This will set all devices to the same sample rate, but will leave all other device configuration settings untouched.



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -130-

DanteUpdater
Dante Updater is a desktop application that allows you to update the Dante firmware and software on Dante
hardware devices. It is installed automatically when you install Dante Controller.

The application is linked to an online database containing firmware update files for products from multiple
manufacturers. When the application is connected to a Dante network, it scans the network and identifies the
firmware versions for each discovered Dante device.

If newer firmware for any device is available in the online database, you can update the device using the online file,
or download the firmware file to your local machine for offline use. If firmware is found for multiple devices in your
network, you can choose to update all devices simultaneously.

You can always easily control which devices get updated.

Launching DanteUpdater

To launch Dante Updater, click the    button in the main toolbar:
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If Dante Updater identifies one or more devices on your Dante network for which new firmware is available, a
notification icon is displayed on the Dante Updater button in the main toolbar:

Launch Dante Updater to review the available updates and update the device(s).
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Troubleshooting

Fanout

About Transmit Flows

Transmit flows are 'streams' of media packets which supply data between devices. Dante devices can support a
finite number of transmit flows, depending on their specific hardware configuration and firmware version.

Dante supports two types of flows - unicast and multicast.

Unicast flows are used to supply media to specific devices, and support up to 4 channels of audio simultaneously,
or 1 channel of video. So if you subscribe 4 audio channels on a receiver to 4 audio channels on a single transmitter,
that audio data will be supplied using one flow. If you were to then subscribe a fifth audio channel, a second flow
would have to be created.

If you were to subscribe 4 different receivers to the same audio channel on a single transmitter, Dante Controller
would have to create 4 unicast flows, because the audio data is going to 4 different places. In this case, it would be
better to create a multicast flow.

A multicast flow 'broadcasts' media across the network, so multiple receivers can subscribe to the media, but the
transmitter is only using one of its available flows. Multicast flows can be configured with up to 64 channels
(depending on the Dante device type). However, multicast media traffic can propagate throughout an entire
network, using up bandwidth on every link in the network. 100Mbps links in particular are easily saturated when
large numbers of multicast flows exist (and would be overwhelmed by 1 channel of video). Therefore, multicast
flows should only be used when there is a good reason to do so.

Multicast flows can carry Dante audio, or RTP audio (AES67 or ST 2110-30).

Note: IGMP snooping must be enabled on network switches that will be carrying Dante video on 1Gbps
network infrastructure. Refer to your switch manufacturer's documentation for information about enabling
IGMP snooping.

If you subscribe a number of devices to one channel via unicast, Dante Controller will alert you with the following
message: “Fanout Configuration detected.”

If you then exceed the supported number of transmit flows, any further subscriptions will fail, and the tooltip for the
failed subscription will read 'No more flows (TX): transmitter cannot support any more flows, reduce fan out by
unsubscribing receivers or switching to multicast.'
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MessagesonStartup

Error Message Meaning & Actions

'Dante Controller was unable to connect to the
Dante Control and Monitoring manager. Dante
Controller cannot function without this connection.
This problem is most likely caused by the Dante
Control and Monitoring ('conmon') service or
daemon stopping unexpectedly. Click OK to restart
Dante Controller. You may also need to manually
restart the Dante Control and Monitoring service,
or the computer, if the problem reoccurs.'

Affects: Windows only.
Meaning: The 'Dante Control and Monitoring'
service is not responding. This can occur after a
computer has been in sleep mode.
Action: Restart Dante Controller. In the event that
does not work, reboot your PC, or restart the Dante
Control and Monitoring service via Control Panel >
Administrative Tools > Services.

'The installed version [x] of the Dante Control and
Monitoring service (‘ConMon’) is out of date.
This version of Dante Controller requires ConMon
version [x] or later.
Please reinstall Dante Controller to resolve this
issue. Dante Controller will now exit.'

Affects: Windows and macOS.
Meaning: Usually this is because the required
service (ConMon) that is installed with Dante
Controller has been overwritten with an older
version by another Dante software product
installation.
Action: Reinstall Dante Controller. This will update
the ConMon service to the latest version.

'The installed version [x] of the Dante Discovery
service is out of date.
This version of Dante Controller requires Dante
Discovery version [x] or later.
Please reinstall Dante Controller to resolve this
issue.
Dante Controller will now exit.'

Affects: Windows only.
Meaning: Usually this is because the required
service (Dante Discovery) that is installed
with Dante Controller has been overwritten with an
older version by another Dante software product
installation.
Action: Reinstall Dante Controller. This will update
the Dante Discovery service to the latest version.

ComputerConfigurationChecklist
Before installing Dante Controller, you must be logged in to your computer as a user with administrator privileges.

To be correctly configured for use with a Dante network, the computer should have:

n Dante Controller installed

n The correct network interface/s selected

n The correct IP addresses in use

Third-party firewall configuration
n Standard Windows and Mac firewalls are typically configured on installation.

n Third party firewalls will need to be manually configured.

If your computer has a third-party firewall installed, please read the Dante Controller and Dante Virtual Soundcard
User Guides for detailed information about firewall requirements and configuration.
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TroubleshootingDante IPAddressConfiguration
All devices in a Dante network, including Dante Virtual Soundcard, must be using IP addresses from the same
network. When using Dante Virtual Soundcard or Dante Controller, your PC or Mac must be connected to the
Primary and/or Secondary Dante network, and must have a correct IP address.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an error
condition, such as an IP address configuration issue, or the device has entered failsafe. Double-click the red
device name to see more information.

Correct IP configuration

Dante hardware devices are set to obtain their IP address automatically from the network. They will either:

n Automatically assign themselves an address in the range 169.254.*.* (172.31.*.* for the secondary network if
present), or

n Obtain an IP address from a DHCP server if it is present on the network

Your PC or Mac TCP/IP network configuration set should be set to 'Obtain an IP address automatically'. This way it
will automatically acquire a Link Local automatic IP address in the same network as other Dante devices. If a DHCP
server is present, the computer and Dante devices will all acquire their IP addresses via DHCP.

Possible IP network configurationmistakes

Possible network configuration errors are listed below. Dante Controller will try to automatically detect these. If
detected the offending device will be displayed in red.

Incorrect PC/Mac IP configuration
n Accidentally having multiple network interfaces with addresses in the same subnet

n If your secondary network is using Link Local (no DHCP server), all devices on that network will be in the
172.31.*.* range. The secondary network interface for the computer must be manually configured (using
static IP addressing) to the same range.

Incorrect general IP configuration
n Accidentally having multiple DHCP servers on the same network

Unusual – for example, someone may have a PC connected to the network with a DHCP server running
that they’re not aware of.

n Incorrectly configured static IP addresses

You shouldn’t typically need to configure static IP addresses at all. If for some reason you do, it must be in
the same subnet as the rest of the network.

Incorrect redundant network configuration
Setting up a redundant network is described in 'Routing Audio'. There are a few ways to incorrectly configure a
redundant network. More than one of these can be present at the same time.

n Connecting the secondary interface of a Dante device to the primary network



Dante Controller

Copyright © 2026 Audinate Pty Ltd. All rights reserved. -135-

Most commonly by either misunderstanding how redundancy works, and using only one switch with all
cables connected to it; or correctly using two switches or networks, but accidentally connecting one
secondary cable to a primary network switch

n Joining the primary and secondary Dante networks

By connecting primary and secondary switches, or perhaps just using one switch.

n Multiple interfaces on the same device using the same IP address subnet

Possibly by having the same DHCP server on both primary and secondary networks, or both DHCP
servers configured to serve the same IP addresses. Also, mixing DHCP and Link Local on the same
network can cause issues. It is often necessary to have all devices and the computer on either DHCP or
Link Local.

What are the symptoms of using the wrong network interface onmy
computer?

If you have more than one wired network interface, and Dante Controller is not using the interface the rest of the
Dante devices are connected to:

n Dante Controller cannot see any Dante devices

n Dante Virtual Soundcard is not sending or receiving any audio when it is expected to

How do I check which network interfaces Dante Controller is using?

n
The selected network interfaces can be viewed or changed via the 'interface selection' button  in the Net-
work View toolbar of Dante Controller.

n If the Dante network is standalone and does not have a DHCP server installed, the addresses should be in
the range 169.254.*.*

n If the Dante network is using a DHCP server, the IP addresses should conform to the addressing scheme it is
using (as shown in the image above)
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How do I check IP addresses for all devices onmy network?
n Use the Device Info tab to view the IP addresses of all the devices on your network.

n The Primary Address of all devices should follow the same IP address scheme. Same for secondary
addresses…

n Note that some older Dante devices or devices running older firmware may not show this information.

TroubleshootingSwitchConfigurationandCabling
Cables are the most vulnerable part of a network system. If you suspect cabling issues, check for:

n Faulty or manually terminated cables

n Unplugged /badly connected Ethernet cables

n Incorrectly configured switches

n Dante devices removed or turned off

Symptoms of switch or cabling issues
n You cannot see (some) devices in the Dante Controller network view

n Dante Controller shows orange “unsuccessful subscription” icons, which usually means a device that was
present earlier is now missing

n Faulty cables can lead to intermittent faults, which may be heard as dropped samples or “cracks” in the audio

n Dante devices may appear and disappear in Dante Controller

Switch and Cabling Checklist
n Are all the connected link/status lights on the switch lit, or flashing as expected?

o Is the switch powered on?
o Is the cable correctly plugged in at the switch and the PC or equipment?

n Is the switch correctly configured?
o Perhaps QoS or VLANs have been incorrectly set up

n Are you using a switch from another application with an unchecked or tested configuration?
o Consult the switch manual and check the switch configuration

Note: Video (Dante AV) devices require at least 1Gbps ports and cables.
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Non-genuineDeviceDetection
Dante Controller dynamically scans your Dante network to check for potentially non-genuine Dante products.

Devices that have been identified as possibly non-genuine will present in orange font in the Routing View, and
Dante Controller will display a pop-up dialog listing the device name(s), with a hyperlink for more information on the
Audinate website.
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Appendix

ResolutionandTimingforDanteAVDevices
This is a description of how video resolutions and timings are negotiated between the HDMI source attached to a
Dante AV Tx endpoint (transmitter) between the Dante AV Tx and Rx endpoints, and the Dante AV Rx endpoint
(receiver) to the HDMI sink/display.

Automatic Operation

Resolution and timing configurations can be set to Auto on the Dante AV transmitter. In this case, when a source
device, such as a camera, computer, or BluRay player, is connected via the input HDMI port to the Dante AV
transmitter, the Dante AV transmitter provides the complete list of supported resolutions and timings to the source
device using EDID (Extended Display Identification Data). The source device then selects one of the available
resolutions and timings from the list and initiates sending a signal.

Figure 3 - Dante AV HDMI Encode (Auto)

Based on the incoming signal resolution and timing, the network connection between the Dante AV transmitter and
Dante AV receivers is configured. The codec will compress video to match the source EDID resolution and timing.

It is entirely up to the source device to select the input video resolution based on the available EDID list presented
by the Dante AV transmitter. The Dante AV transmitter provides 49 different resolution and timing settings.

On the receive end, the Dante AV receiver requests the EDID from the sink/display device attached to the output
HDMI port. It then compares the available resolutions and timings to the subscribed Dante AV transmitter. Where
possible, the signal is decoded and passed at native resolution (the same resolution and frame rate as the source).
However, if the EDID of the sink/display only provides resolutions lower than the source, the video will be
downscaled to match the capabilities of the sink/display. There is no upscaling available with Dante AV receivers.
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Figure 4 - Dante AV HDMI Decode (Auto)

The Dante AV receiver is capable of downscaling the following:

n 4096x2160p to 3840x2160p

n 3840x2160p to 1920x1080p

n 1920x1080p to 1280x720p

The frame rate, or timing, of a video signal transported over Dante AV cannot be modified. At present, if the source
provides a 60fps signal into the Dante AV transmitter, then all sinks to Dante receivers must be capable of
supporting 60fps. Frame rate will generally be favored over resolution.

For instance, if the source is providing a 3840x2160p60 input to the Dante AV transmitter, and the sink device (for
example, a display monitor) attached to a Dante AV receiver can only support 3840x2160p30, you might get
1920x1080p60 as the output.

If the frame rate is not supported by the sink device attached to the Dante AV receiver, then no signal will be
passed.

Manual Operation

Using Dante Controller, you can manually set the input resolution, frame rate, color bit depth, and chroma
subsampling for the Dante AV transmitter. By doing so, you will limit the EDID list of supported resolution and
timings to only the manual settings. The HDMI source will need to support whatever setting is made. The
codec/network transmission will follow the input EDID settings made using Dante Controller.
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Figure 5 - Dante AV HDMI Encode (Manual)

After you save your resolution and timing settings using Dante Controller to the Dante AV transmitter, the Hot Plug
Detect channel on HDMI is toggled off and on in order to initiate an EDID renegotiation with the source. It is up to the
source to detect the Hot Plug Detect signal and initiate renegotiation using the new EDID list and select the
appropriate input resolution and timing.

On the Dante AV receiver, the function is identical to automatic mode.

Figure 6 - Dante AV HDMI Decode (Manual)

PresetElements-ConfigurationParameters
This page provides a comprehensive list of preset elements and the configuration parameters that are set as part of
each element when applying presets to Dante devices.

The supported parameter set for a device varies according to device type.
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Device Name

Configuration Parameters
n Friendly Name: Sets the user-friendly name of the device

n Intermediate Name: Temporary name used during rename operations to avoid naming conflicts

Notes
n Handles name conflict resolution through intermediate naming

n Supports renaming multiple devices in a single preset application

n Monitors timeout for rename operations (40 seconds)

Device Redundancy

Configuration Parameters
n Redundancy Mode: Enable/disable switch redundancy

Notes
n Only applies to devices with switch redundancy support

n May trigger a device reboot requirement

Switch VLANConfiguration

Configuration Parameters
n VLAN Mode: Switch VLAN configuration value

Notes
n Only applies to devices with VLAN support

n May trigger a device reboot requirement

Interface IPv4 Addresses

Configuration Parameters
n IP Address Mode: Static or DHCP

n IP Address: Static IPv4 address

n Network Mask: Subnet mask

n Gateway: Default gateway address

n DNS Server: DNS server address
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Notes
n Configures each network interface independently

n Only applies static IP configuration

n May trigger a device reboot requirement

n Requires device to support static IP addressing

Sample Rate

Configuration Parameters
n Sample Rate: Audio sample rate in Hz (e.g., 48000, 96000)

Notes
n Has extended timeout (10 seconds) for completion

n May trigger a device reboot requirement

n Only applies if device supports sample rate configuration

Sample Rate Pull-up

Configuration Parameters
n Pull-up Value: Sample rate pull-up/pull-down setting

Notes
n May trigger a device reboot requirement

n Only applies to devices that support pull-up configuration

n Not available for devices in domains

Audio Encoding

Configuration Parameters
n Encoding Format: Audio encoding type (e.g., PCM16, PCM24, PCM32)

Notes
n May trigger a device reboot requirement

n Only applies if device supports encoding configuration

Device Unicast Latency

Configuration Parameters
n Latency (μs): Unicast latency in microseconds

n FPP (Frames Per Packet): Calculated from latency value
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Notes
n Uses latency scheme to determine appropriate FPP value

n Only applies to devices that support latency configuration

RTPConfiguration

Configuration Parameters
RTP Mode:

n Interop Mode: "Off", "AES67", or "ST2110-30"

n Configures device for AES67 or SMPTE ST 2110 compatibility

AES67 Parameters:

n AES67 Multicast Prefix: Multicast address prefix for AES67 flows

RTP Parameters (modern devices only):

n Encoding: RTP flow format/encoding

n Latency: RTP/interop latency in microseconds

n Unicast Port: RTP unicast port number

n Payload Type: RTP payload type identifier

Notes
n Different handling for legacy vs. modern interop devices

n May trigger a device reboot requirement (for mode changes)

n Only applies to AES67-capable devices

Clock Configuration

Configuration Parameters
n Subdomain Name: PTP subdomain name

n Danteness Disabled: Disable Dante-specific PTP extensions

n Priority Mapping: PTP priority mapping configuration

n Unicast Delay Requests: Enable unicast delay request messages

n V1 Unicast Delay Requests: PTPv1 unicast delay requests

n V2 Unicast Delay Requests: PTPv2 unicast delay requests

n V2 DSCP: PTPv2 DSCP (QoS) value

n V2 Domain Number: PTPv2 domain number

n V1 Enabled: Enable PTPv1 protocol

n V2 Enabled: Enable PTPv2 protocol

n V2 Sync Interval: PTPv2 sync message interval
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n V2 Announce Interval: PTPv2 announce message interval

n Multicast TTL: Time-to-live for multicast PTP messages

Notes
n Comprehensive PTP clock configuration

n Configures both PTPv1 and PTPv2 parameters independently

n Port-specific configurations for sync/announce intervals

Clock Priority Configuration

Configuration Parameters
n Preferred Master: Set as preferred PTP master (legacy mode)

n V2 Priority1: PTPv2 Priority1 value (manual clock mode)

n V2 Priority2: PTPv2 Priority2 value (manual clock mode)

n Follower Only: Set device as follower-only (slave-only mode)

Notes
n Different settings used based on device clock mode (manual vs. automatic)

n Checks device capabilities before applying settings

ExternalWord Clock

Configuration Parameters
n Clock Source: Internal or External word clock

Notes
n Only applies to devices with selectable external word clock

HA Remote BridgeMode

Configuration Parameters
n Bridge Mode: High Availability Remote bridge mode value

Notes
n Only applies to devices with HA Remote support

Codec Configuration

Configuration Parameters
n Codec Type: Type of codec

n Codec Mode: Operating mode for the codec
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n Codec Values: Array of codec parameter values per channel

Notes
n Only applies to codec-capable devices

n Configures multiple codec channels with individual parameter values

n Each channel gets its own codec control parameter set

Transmit Channel Names/Labels

Configuration Parameters
n Channel Name: User-defined label for each transmit channel

n Applies to all media types (audio, video)

Notes
n First deletes existing labels, then sets new ones

n Supports multiple labels per channel (first label is used)

n Applied per media type (audio, video)

Transmit Flows

Configuration Parameters
Common to All TX Flows:

n Flow ID: Multicast flow identifier (auto-allocated if not specified)

n Media Type: Audio or video

n Slots: Array of transmit channel IDs in the flow

Dante (ATP) Audio Flows:

n FPP (Frames Per Packet): Configurable or auto-calculated based on channel count

RTP Audio Flows:

n FPP (Frames Per Packet): Frames per packet

n Session ID: RTP/SDP session identifier

n Destination Addresses: Array of multicast/unicast destination IP addresses and ports

Video Flows:

n Slots: Video channel assignments

Notes
n First deletes existing flows, then creates new ones

n Automatically allocates available flow IDs

n Reuses flow IDs for flows with matching configurations
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n Validates slot count against device capabilities

n Different configurations for Dante vs. RTP flows

Receive Channel Names

Configuration Parameters
n Channel Name: User-defined name for each receive channel

n Applies to all media types (audio, video)

Notes
n Sets receive channel names for identification

n Applied per media type

Receive Channel Subscriptions

Configuration Parameters
n Subscribed Device: Name of source device

n Subscribed Channel: Name of source channel on the device

n Creates Dante subscriptions (unicast connections)

Notes
n First unsubscribes all channels, then creates new subscriptions

n Establishes audio/video routing connections

n Only handles Dante subscriptions (not RTP/AES67 subscriptions)

n Validates against locked channels and self-subscription

Receive Flows

Configuration Parameters
RTP Audio RX Flows:

n Flow ID: Receive flow identifier (auto-allocated if not specified)

n Media Type: Audio

n Slots: Array of arrays of receive channel IDs (multi-dimensional for multichannel flows)

n Source Addresses: Array of source IP addresses and ports

n Encoding: Audio encoding format

n Clock Offset: RTP media clock offset

n RTP SDP Origin Address: SDP session origin IP address

n RTP SDP Session ID: SDP session identifier
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Notes
n Only RTP audio receive flows currently supported

n First deletes existing flows, then creates new ones

n Automatically allocates available flow IDs

n Reuses flow IDs for flows with matching configurations

n Validates slot count against device capabilities

Device Reboot Requirements

Certain configuration changes may require a device reboot:

n Switch redundancy changes

n Switch VLAN configuration changes

n Interface address changes

n Clock pull-up changes

n Sample rate changes

n Encoding changes

n RTP mode changes
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